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About This Guide

IMPORTANT! Before using this product, read and understand the information the

“Safety” appendix in this document.

Revision history

Revision

Date

Description

A

November 2012

New document

B

February 2013

e Remove 3100/3100 Avant instrument information
¢ Add information on:
- Optimum PCR cycle and peak height guidance

- Validate DNA extraction and quantification
methods are validated for use with PCR
amplification

March 2013

Perform PCR: Add statement to perform internal
validation studies to optimize the DNA template
input quantity for STR amplification to obtain optimal
peak height.

Purpose

The AuthentiFiler™ PCR Amplification Kit User Guide provides information about the
Applied Biosystems® instruments, chemistries, and software associated with the
AuthentiFiler ™ PCR Amplification Kit.
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Overview

Pu rpose The AuthentiFiler™ PCR Amplification Kit is a short tandem repeat (STR) multiplex
PCR assay that amplifies 9 unique STR loci (8 loci comprise tetranucleotide repeat
units and one locus trinucleotide) and the Amelogenin gender-determining marker in
a single PCR amplification. The kit uses more loci concentrated in the shorter
fragments (or smaller amplicons) region of the profile to improve performance on
degraded samples, and an improved process for synthesis and purification of the
amplification primers to deliver a much cleaner electrophoretic background.

Note: The quality of sample, the DNA extraction method used, and the quality of
DNA extract may affect the data quality of profiles.

The AuthentiFiler " Kit is intended for use in human cell identification in various
research based applications requiring cell discrimination and identity confirmation,
such as human cell line authentication testing and induced pluripotent stem cell (iPSC)
genetic confirmation testing.

Following extraction of gDNA and amplification of STR loci, the amplified PCR
fragments are run along with allelic ladder size standards to generate genotypes for
each amplified loci. The combination of genotypes creates a unique and highly
discriminatory pattern that can differentiate the cell with a probability of identity of
approximately 7.75x 10712,

Product The AuthentiFiler™” PCR Amplification Kit contains all reagents necessary (PCR
description Master Mix, PCR Oligo Mix) for the amplification of target loci from 2 ng of human
gDNA. In addition, the kit contains control gDNA of known genotype in the form of a
positive control and an allelic ladder, which is run alongside unknown fragments to
enable genotype determination on the Capillary Electrophoresis instrument using
GeneMapper® Software.
The reagents are designed for use with the following Life Technologies instruments:
* Applied Biosystems® 3130/3130x! Genetic Analyzer
* Applied Biosystems® 3500/3500xL Genetic Analyzer
* GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

o Veriti® 96-Well Thermal Cycler

AuthentiFiler™ PCR Amplification Kit User Guide 9



Overview

About the primers

Loci amplified by
the kit

Chapter 1 Overview

The AuthentiFiler Kit uses the same primer sequences as the AmpF(STR® NGM
SElect™ Kit for all loci except D651043 which uses the same primer sequences as
AmpF(STR® Sinofiler™ Kit and D251338 which uses the same primer sequences as
AmpF(STR® MiniFiler" Kit, and benefits from the same primer synthesis and
purification improvements. These improvements enhance the assay signal-to-noise
ratio and simplify the interpretation of results.

The following table shows the loci amplified, their chromosomal locations, and the
corresponding fluorescent marker dyes. The AuthentiFiler'" Allelic Ladder is used to
genotype the analyzed samples. The alleles contained in the allelic ladder and the

genotype of the AuthentiFiler'" DNA Control 007 are also listed in the table.

Table 1 AuthentiFiler™ PCR Amplification Kit loci and alleles

Locus designation Chromosome Category; Alleles included in Dye Ct?r::fol
9 location Repeat motif | AuthentiFiler™ Allelic Ladder label 007
D1051248 10g26.3 Simple; GGAA 8,9,10,11,12,13, 14,15, 16,17, | 6-FAM™ 12,15
18
D151656 1q42.2 Compound; 9,10, 11, 12, 13, 14, 14.3, 15, 6-FAM™ 13, 16
TAGA 15.3,16,16.3,17,17.3,18.3, 19.3,
20.3
Amelogenin X: p22.1-22.3 XY vVIC® XY
Y: p11.2
D251338 2935 Compound; 15, 16, 17, 18, 19, 20, 21, 22, 23, | VIC® 20, 23
TGCC/TTCC 24, 25, 26, 27, 28
D2251045 22q12.3 Simple; ATT 8,9,10, 11,12, 13, 14, 15, 16, 17, | NED™ 11,16
18, 19
D19S433 19912 Compound; 9,10, 11,12, 12.2, 13, 13.2, 14, NED™ 14,15
AAGG/TAGG 14.2, 15, 15.2, 16, 16.2, 17, 17.2
THO1 11p15.5 Simple; TCAT 4,5,6,7,8,9 93,10, 11, 13.3 NED™ 7, 9.3
D2S441 2pl4 Compound; 9,10, 11, 11.3, 12, 13, 14, 15, 16 | PET® 14, 15
TCTA/TCAA
D651043 6916.1 Compound; 9,10, 11,12, 13, 14,15, 16,17,18, | PET® 12, 14
AGAT/AGAC 19, 20, 21, 21.3, 22, 23, 24, 25
D125391 12p13.2 Compound; 14,15, 16,17, 18,19, 19.3, 20, 21, | PET® 18, 19
AGAT/AGAC 22, 23, 24, 25, 26, 27
10 AuthentiFiler™ PCR Amplification Kit User Guide



Chapter 1 Overview
Overview

Allelic ladder Figure 1 shows the allelic ladder for the AuthentiFiler" Kit. See “Allelic ladder
profile requirements” on page 23 for information on ensuring accurate genotyping.

Figure 1 GeneMapper® ID-X Software plot of the AuthentiFiler™ Allelic Ladder
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1 Chapter 1 Overview
Overview

AuthentiFiler™ Figure 2 shows amplification of DNA Control 007 using the AuthentiFiler" Kit.
DNA Control 007
profile

Figure 2 2 ng of AuthentiFiler™ DNA Control 007 amplified at 27 PCR cycles with the AuthentiFiler™ Kit and analyzed on the
Applied Biosystems® 3130x( Genetic Analyzer
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Workflow overview

Chapter 1 Overview
Workflow overview

Extract DNA
Perform

PCR .
Quantify DNA

AuthentiFiler™ PCR Amplification Kit

Prepare
reactions

~

GeneAmp® PCR System 9700 Cycler

>

Perform
PCR

Veriti® 96-Well Thermal Cycler

Perform
electro-
phoresis

=]

o]

3130/3130x!
Genetic Analyzer

3500/3500xL

Genetic Analyzer

Analyze | m
data 'u F:
B ,3’ &
l e — =
GeneMapper® ID-X, GeneMapper® /D Software, or GeneMapper® v4.1 Software (and higher)
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Instrument and software overview

Instrument and software overview

Data Collection and
GeneMapper® ID,
GeneMapper® ID-
X, or GeneMapper®

Software

Instrument and
software
compatibility

About
multicomponent
analysis

How
multicomponent
analysis works

14

This section provides information about the Data Collection Software versions
required to run the AuthentiFiler' Kit on specific instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software stores
information about each sample in a sample file (.fsa files for 3130 instruments and .hid
files for 3500 instruments), which is then analyzed by the GeneMapper® ID,
GeneMapper® ID-X, or GeneMapper® Software.

Table 2 Software specific to each instrument

Data Collection

Instrument Operating system Software Analysis software
3500/3500xL e Windows® XP 3500 Series GeneMapper® [D-X Software
o Windows Vista® | Data Collection | v1.2 or higher
Software v1.0
3130/3130x(* Windows® XP 3.0 e GeneMapper® ID

Software v3.2.1
or

e GeneMapper® ID-X
Software v1.0.1 or higher
or

» GeneMapper® Software
v4.1 or higher

+ We conducted validation studies for the AuthentiFiler™ Kit using this configuration.

Our fluorescent multi-color dye technology allows the analysis of multiple loci,
including loci that have alleles with overlapping size ranges. Alleles for overlapping
loci are distinguished by labeling locus-specific primers with different colored dyes.

Multicomponent analysis is the process that separates the 5 different fluorescent dye
colors into distinct spectral components allowing for fragment size resolution on
Applied Biosystems® Genetic Analyzers. The four dyes used in the AuthentiFiler'
PCR Amplification Kit to label samples are 6-FAM"", VIC®, NED", and PET® dyes.
The fifth dye, LIZ®, is used to label the GeneScan"" 500 LIZ® Size Standard or
GeneScan'" 600 LIZ® Size Standard v2.0.

M

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Applied Biosystems® instruments, the
fluorescence signals are separated by diffraction grating according to their
wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM " dye emits at the shortest wavelength and it is
displayed as blue, followed by the VIC® dye (green), NED"" dye (yellow), PET® dye
(red), and LIZ® dye (orange).

AuthentiFiler™ PCR Amplification Kit User Guide



Chapter 1 Overview
Materials and equipment

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 3).
The goal of multicomponent analysis is to correct for spectral overlap.

Figure 3 Emission spectra of the five dyes used in the AuthentiFiler™ Kit
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Materials and equipment

Kit contents and
storage

The AuthentiFiler™ Kit contains materials sufficient to perform 50 amplifications
(Cat. no. 4479566) at a 25 pL reaction volume.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standards from light when not
in use. Keep freeze-thaw cycles to a minimum.

Table 3 Kit contents and storage

Component Description 50X Volume Storage
AuthentiFiler™ | Contains forward and reverse 1 tube, 0.25 mL -15 to -25°C on
Primer Set primers to amplify human DNA receipt, 2 to 8 °C

targets.

AuthentiFiler™
Allelic Ladder

Contains amplified alleles.

See Table 1 on page 10 for a list
of alleles included in the allelic
ladder.

1 tube, 0.025 mL

after initial use;
protect from light

AuthentiFiler™
Master Mix

Contains enzyme, salts, dNTPs,
carrier protein, and 0.05%
sodium azide.

1 tube, 0.5 mL

AuthentiFiler™
DNA Control
007

Contains 2 ng/pL human male
DNA in 0.05% sodium azide and
bufferT.

See Table 1 on page 10 for
profile.

1 tube, 0.025 mL

-15 to -25°C on
receipt, 2 to 8 °C
after initial use

t+ The AuthentiFiler™ DNA Control 007 is included at a concentration appropriate to its intended use as an
amplification control (to provide confirmation of the capability of the kit reagents to generate a profile of
expected genotype). The AuthentiFiler™ DNA Control 007 is not designed to be used as a DNA quantitation

control, and laboratories may expect to see variation from the labelled concentration when quantitating aliquots
of the AuthentiFiler™ DNA Control 007.

AuthentiFiler™ PCR Amplification Kit User Guide 15



Standards for
samples

16

Chapter 1 Overview
Materials and equipment

For the AuthentiFiler"" Kit, the panel of standards needed for PCR amplification, PCR
product sizing, and genotyping are:

* AuthentiFiler™ DNA Control 007 — A positive control for evaluating the

efficiency of the amplification step and STR genotyping using the AuthentiFiler"™
Allelic Ladder.

GeneScan"" 500 LIZ® Size Standard (GS 500) or GeneScan'" 600 LIZ® Size
Standard v2.0 (GS 600 v2.0) — Used for obtaining sizing results. These standards,
which have been evaluated as internal size standards, yield precise sizing results
for AuthentiFiler™ Kit PCR products. Order the GeneScan"" 500 LIZ® Size
Standard (Cat. no. 4322682) or the GeneScan"" 600 LIZ® Size Standard v2.0

(Cat. no. 4408399) separately.

AuthentiFiler™ Allelic Ladder — Allelic ladder developed by Life Technologies
for accurate characterization of the alleles amplified by the AuthentiFiler" Kit.
The AuthentiFiler™ Allelic Ladder contains most of the alleles reported for the

9 autosomal loci. See Table 1 on page 10 for a list of the alleles included in the
AuthentiFiler™ Allelic Ladder.

AuthentiFiler™ PCR Amplification Kit User Guide
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Required user-supplied materials and reagents

In addition to the AuthentiFiler"™ Kit reagents, the use of low-TE buffer (10 mM Tris,
0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as described in the
procedure below or order it from Teknova (Cat. no. T0223).

To prepare low-TE buffer:

1. Mix together:
¢ 10mL of 1 M Tris-HC], pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes based on your specific needs.
2. Aliquot and autoclave the solutions.

3. Store at room temperature for appropriate period.

DNA extraction

Note: The quality of sample, the DNA extraction method used, and the quality of
DNA extract may affect the data quality of profiles.

Extract DNA using a method you have validated in your laboratory.

IMPORTANT! Validate DNA extraction methods for use with PCR amplification before
preparing samples for use with the AuthentiFiler™ Kit.

AuthentiFiler™ PCR Amplification Kit User Guide 17
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DNA quantification

DNA quantification

Importance of DNA
quantification

Methods of
quantifying DNA

18

Extract DNA using a method you have validated in your laboratory.

IMPORTANT! Validate DNA quantification methods for use with PCR amplification
before preparing samples for use with the AuthentiFiler " Kit.

Quantifying the amount of extracted gDNA in a sample before amplification allows
you to determine whether or not sufficient DNA is present to permit amplification and
to calculate the optimum amount of DNA to add to the reaction. The optimum amount
of DNA for the AuthentiFiler" Kit is 2.0 ng in a maximum input volume of

10 pL amplified for 27 cycles.

Perform internal validation studies to optimize the DNA template input quantity for
STR amplification to obtain optimal peak height.

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data). Off-scale data are problematic because:

— Quantification (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur, resulting in a partial profile.

Our studies indicate the optimum PCR cycle number should generate profiles with the
following heterozygote peak heights, with no instances of allelic dropout and minimal
occurrence of off-scale allele peaks:

Instrument Heterozygous peak height
3130 Series 1500-3000 RFU
3500 Series 3000-6000 RFU

We recommend using a human-specific quantification method such as found in
Quantifiler® Kits for better correlation between the quantity of template DNA used for
amplification and the electrophoresis results (rfu of allele peaks). We provide several
kits for quantifying DNA in samples. See the references cited in the following table for
details about these kits.

Additional DNA quantification methods can be used, for example, spectrophotometer/
NanoDrop ™ 1000 Spectrophotometer, etc.

AuthentiFiler™ PCR Amplification Kit User Guide



Chapter 2 PCR Amplification
DNA quantification

Product Description References

Quantifiler® Human DNA Properties: Quantifiler® Human DNA
Quantification Kit Quantification Kits User's Manual

L ® o o
(Cat. no.4343895) The Quantifiler® Human Kit is highly specific for (Pub. no. 4344790)

human DNA and detects total human DNA. The kits
detects amplifiable DNA.

How it works:

The Quantifiler® DNA Quantification Kit consists of
target-specific and internal control 5’ nuclease
assays.

The Quantifiler® Human Kit consists of a human
DNA target-specific assay that contains two locus-
specific PCR primers and one TagMan® MGB
probe labeled with 6-FAM™ dye for detecting the
amplified sequence. The kit contains a separate
internal PCR control (IPC) assay that consists of an
IPC template DNA (a synthetic sequence not found
in nature), two primers for amplifying the IPC
template DNA, and one TagMan® MGB probe
labeled with VIC® dye for detecting the amplified
IPC DNA.

Quantifiler® Duo DNA Properties: Quantifiler® Duo DNA
Quantification Kit Quantification Kit User's Manual
(Cat. no. 4387746) (Pub. no. 4391294)

The Quantifiler® Duo Kit is highly specific for
human DNA and combines the detection of both
total human and human male DNA in one PCR
reaction.The kit detects amplifiable DNA.

How it works:

The Quantifiler® Duo DNA Quantification Kit
consists of target-specific and internal control 5’
nuclease assays.

The Quantifiler® Duo Kit combines two human-
specific assays in one PCR reaction [for total
human DNA and human male DNA). The two
human DNA specific assays each consist of two
PCR primers and a TagMan® probe. The TagMan®
probes for the human DNA and human male DNA
assays are labeled with VIC® and 6-FAM™ dyes,
respectively. In addition, the kit contains an internal
PCR control (IPC) assay similar in principle to that
used in the other Quantifiler® Kits, but labeled with
NED™ dye.

AuthentiFiler™ PCR Amplification Kit User Guide 19
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Prepare the amplification kit reactions

Prepare the amplification kit reactions

20

1.

Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction
AuthentiFiler™ Master Mix 10.0 pL
AuthentiFiler™ Primer Set 5.0 uL

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

Prepare reagents. Thaw the AuthentiFiler' Master Mix and the AuthentiFiler™
Primer Set, then vortex the tubes for 3 seconds and centrifuge them briefly before
opening.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2-8°C and, therefore, do not require subsequent thawing.
Do not refreeze the reagents.

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the reaction mix for 3 seconds, then centrifuge briefly.

Dispense 15 UL of reaction mix into each reaction well of a MicroAmp® Optical
96-Well Reaction Plate or each MicroAmp® tube.

Prepare the DNA samples:
DNA sample To prepare...
Negative control Add 10 pL of low-TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0J.
Test sample Dilute a portion of the test DNA sample with low-TE buffer so

that 2.0 ng of total DNA is in a final volume of 10 yL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 1 pL of AuthentiFiler™ DNA Control 007 (2.0 ng/uL) to
provide 2.0 ng of total DNA in the positive control reaction. Add
9 pL of low-TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) to get
a final volume of 10 pL.

The final reaction volume (sample or control plus reaction mix) should be 25 pL.

Seal the MicroAmp® Optical 96-Well Reaction Plate with MicroAmp® Clear
Adhesive Film or MicroAmp® Optical Adhesive Film, or cap the tubes.

Centrifuge the tubes or plate at 3000 rpm for about 20 seconds in a tabletop
centrifuge (with plate holders if using 96-well plates) to remove bubbles.

AuthentiFiler™ PCR Amplification Kit User Guide



Perform PCR

Chapter 2 PCR Amplification
Perform PCR

9. Amplify the samples in a GeneAmp® PCR System 9700 with the Silver 96-well

block, or a GeneAmp® PCR System 9700 with the Gold-plated Silver 96-well
block, or a Veriti® 96-well Thermal Cycler.

IMPORTANT! The AuthentiFiler™ Kit is not validated for use with the GeneAmp®
PCR System 9700 with the Aluminium 96-well block. Use of this thermal cycling
platform may adversely affect the performance of the AuthentiFiler" Kit.

. Program the thermal cycling conditions.

*  When using the GeneAmp® PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

* When using the Veriti® 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti® 96-Well Thermal Cycler
AmpF(STR® Kit Validation (Pub. no. 4440754).

Initial Cycle (27 cycles) Final Final hold
incubation step Denature | Anneal extension
and
Extension
HOLD CYCLE HOLD HOLD
95°C 94°C 59°C 60°C 4°C
11 min 20 sec 3 min 10 min )

IMPORTANT! The optimum conditions for the AuthentiFiler " Kit are 27 cycles
of amplification with a 2 ng input DNA concentration. Perform internal
validation studies to evaluate kit performance at each cycle number intended for
operational use.

Perform internal validation studies to optimize the DNA template input quantity
for STR amplification to obtain optimal peak height.

Note: If using genomic DNA isolated from FFPE tissues, use 2 ng DNA input and
above mentioned PCR cycling conditions with 29 cycles.

. Load the plate or tubes into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure to
place a MicroAmp® Compression Pad (Cat. no. 4312639) on top of the plate to
prevent evaporation during thermal cycling.

3. Start the run.
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4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the amplified DNA... Then place at...
< 1 week 2 to 8°C
> 1 week -15to0 -20°C

Note: The signal strength of the VIC channel artifact increases with storage of the
amplification plate at 4°C, most commonly when plates are left at 4°C for a few
days. We recommend storing amplification products at —20°C.

IMPORTANT! Store the amplified products so that they are protected from light.
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B Allelic ladder requirements. . ........ ... . i i 23
Section 3.1 3130/3130xl instruments . ............... it 24
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Section 3.2 3500/3500XL inStruments . .. ...ttt 27
B Set up the 3500/3500xL instrument for electrophoresis ..................... 27
B Prepare samples for electrophoresis on the 3500/3500xL instrument. . ... ... .. 27

Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of One .
. L Number of samples per allelic
Instrument allelic ladders injection
ladder(s)
to run equals
3130 1 per 4 injections | 4 samples 15 samples + 1 allelic ladder
3130x( 1 per injection 16 samples | 15samples + 1 allelic ladder
3500 1 per 3 injections | 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples | 23 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples, because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.

AuthentiFiler™ PCR Amplification Kit User Guide 23



Chapter 3 Electrophoresis

Set up the 3130/3130x! instruments for electrophoresis

Section 3.1 3130/3130x( instruments

Set up the 3130/3130x( instruments for electrophoresis

Reagents and parts

Electrophoresis
software setup and

supplied with the AuthentiFiler"" Kit.

Appendix B, “Ordering Information” on page 87 lists the required materials not

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

documents listed in the table.

The following table lists data collection software and the run modules that can be used
to analyze AuthentiFiler" Kit PCR products. For details on the procedures, refer to the

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3.0t Windows® ¢ HIDFragmentAnalysis36_POP4_1 = Applied Biosystems® 3130/3130x!
Biosystems® XP Injection conditions: Genetic Analyzers Using Data
3130/3130x( Collection Software v3.0, Protocols

- 3130 = 3 kV/5 sec
- 3130x( = 3 kV/10 sec
e Dye Set G5

for Processing AmpFISTR® PCR
Amplification Kit PCR Products User
Bulletin (Pub. no. 4363787)

t+ We conducted validation studies for the AuthentiFiler™ Kit using this configuration.

24
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Section 3.1 3130/3130xl instruments

Prepare samples for electrophoresis on the 3130/3130x( instruments

Prepare samples for electrophoresis on the 3130/3130x!(

instruments

Prepare the samples for electrophoresis on the 3130/3130x! immediately before
loading.

1.

 ® N o

Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GS 500 LIZ® Size Standard or 0.5puL
GS 600 LIZ® Size Standard v2.0
Hi-Di"™" Formamide 9.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.
Into each well of a MicroAmp® Optical 96-Well Reaction Plate, add:

® 10 L of the formamide:size standard mixture
¢ 1 pL of PCR product or Allelic Ladder
Note: For blank wells, add 11 uL of Hi-Di"" Formamide.

Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.
Prepare the plate assembly on the autosampler.

Start the electrophoresis run.

Note: Expected heterozygote peak heights are 1500-3000 RFU.
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3 Chapter 3 Electrophoresis
Prepare samples for electrophoresis on the 3130/3130x! instruments
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Set up the 3500/3500xL igsh:frtni:)? foEl:l(;tcrt(;E;hoorrii:
Section 3.2 3500/3500xL instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts Appendix B, “Ordering Information” on page 87 lists the required materials not
supplied with the AuthentiFiler"" Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

w
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Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze AuthentiFiler"" Kit PCR products. For details on the procedures, refer
to the documents listed in the table.

reference
documents
Genetic Data Operatin
Collection P 9 Run modules and conditions References
Analyzer System
Software
Applied 3500 Data Windows® e HID36_POP4 Applied Biosystems® 3500/
Biosystems® Collection XP Injection conditions: 1.2kV/15 sec 3500xL Genetic Analyzer User
3500 Software v1.0 Guide (Pub. no. 4401661)
or e Dye Set G5
Applied Windows o HID36_POP4 5008 and S Denelc
gé%%);sl_tems@ Vista ® Injection conditions: 1.2kV/24 sec Carc;/[Pub. no. 4401662)
e Dye Set G5

Prepare samples for electrophoresis on the 3500/3500xL
instrument

Prepare the samples for capillary electrophoresis on the 3500/3500xL instrument
immediately before loading.

1. Calculate the volume of Hi-Di'" Formamide and Size Standard needed to prepare
the samples, using the table below.

Reagent Volume per reaction
GeneScan™ 600 LIZ® Size Standard v2.0 05 uL
Hi-Di™ Formamide 9.5 L

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.
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3 Chapter 3 Electrophoresis
Prepare samples for electrophoresis on the 3500/3500xL instrument

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp® Optical 96-Well Reaction Plate, or each
MicroAmp® optical strip tube, add:

a. 10 pL of the formamide: size standard mixture
b. 1 pL of PCR product or Allelic Ladder

Note: For blank wells, add 11 uL of Hi-Di"" Formamide.
5. Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to
ensure that the contents of each well are collected at the bottom.
Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.
Prepare the plate assembly, then put it onto the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

© ® ® N o

1

Start the electrophoresis run.

Note: Expected heterozygote peak heights are 3000-6000 RFU.
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B Examineand editaproject ......... ... .. i 40
B Formoreinformation........... ... i 40
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B Set up GeneMapper® ID-X Software for data analysis. ..................... 42
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Section 4.1 GeneMapper® ID Software

Overview of GeneMapper® /D Software

GeneMapper® ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the Data Collection Software stores information for each sample
in an .fsa file. Using GeneMapper® ID Software v3.2.1, you can then analyze and
interpret the data from the .fsa files.

Instruments See “Instrument and software overview” on page 14 for a list of compatible
instruments.

AuthentiFiler™ PCR Amplification Kit User Guide 29



4 Chapter 4 Data Analysis
Set up GeneMapper® ID Software for data analysis

Before you start

When using GeneMapper® ID Software v3.2.1 to perform human identification (HID)
analysis with STR kits, be aware that:

HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.

For multiple ladder samples, the GeneMapper® ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles may
contain full and/or partial repeat units. An off-ladder allele is an allele that occurs
outside the +0.5-nt bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.

Set up GeneMapper® ID Software for data analysis

File names

Overview

30

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com.

To analyze sample (.fsa) files using GeneMapper® ID Software v3.2.1 for the first time:

1.

Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 31.

Create an analysis method, as explained in “Create an analysis method” on
page 34.

Create a size standard, as explained in “Create a size standard” on page 38.

Define custom views of analysis tables.

Refer to the GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Pub. no. 4335523) for more information.

Define custom views of plots.

Refer to the GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Pub. no. 4335523) for more information.
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Section 4.1 GeneMapper® ID Software 4
Set up GeneMapper® ID Software for data analysis

Impo rt panels and To import the AuthentiFiler™ Kit panel and bin set from www.lifetechnologies.com
bins into the GeneMapper® ID Software v3.2.1 database:
1. Download and open the file containing panels and bins:

a. From the Support menu of www.lifetechnologies.com, select
Support » Software Downloads, Patches & Updates » GeneMapper® ID
Software v 3.2 » Updates & Patches, and download the file AuthentiFiler
Analysis Files GMID.

b. Unzip the file.

2. Start the GeneMapper® ID Software, then log in with the appropriate user name
and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID Software Version
3.1 Human Identification Analysis User Guide (Pub. no. 4338775).
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3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

. [#.Panel Manager
b. Select File » Import Panels to open the Import e Edt Bins  View

Panels dialog box.

= N R

== Panel Manager

c. Navigate to, then open the AuthentiFiler
Analysis Files GMID folder that you unzipped in
step 1 above.

5. Select AuthentiFiler_Final GMID3.2_Panels.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, AuthentiFiler_Final. This folder contains the panel and associated

markers.
.E-‘_:Impurt Panels 4 2_(_[
Lockin:  |C2) GMID 3.2 AuthentiFiler panels and bins 2l 2 oEE
[Z] AuthertiFiler_Final_GMID3.2_bins tx
B suhentiFiler _Final_GMID3.2_Panels txt
CUGEST U | =) suthentiFiler_GMIDS.2_AnalysisMethod xmi
Desktop
My Documents
o 8
My Computer
My Metweork ...
File name: |AuthentiFiler_Final_GMID3.2_Panels 1xt Impart |
Files of type:  [an Files x| cancel |

6. Import AuthentiFiler_Final GMID3.2_bins.txt:
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Chapter 4 Data Analysis

Set up GeneMapper® ID Software for data analysis

a. Select the AuthentiFiler_Final folder in the navigation pane.

(®)Panel Manager

File Edit Bins View

X || || DR[| |Binset [autnertFier bins Final ||| |
Puns] Haze
‘ uthentiFiler_panel_Final

F-E3Panel Manager Commnent

3 Bl A thertiFiler_Final 1

Select File » Import Bin Set to open the Import Bin Set dialog box.
Navigate to, then open the AuthentiFiler Analysis Files GMID folder.
Select AuthentiFiler Final GMID3.2_bins.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AuthentiFiler_Final folder.

@ JImport Panels

= ” sEE

I@ GMID 3.2 AuthertiFiler panels and bins

B 2uthentiFiler_Fir ns txt
EI AuthertiFiler_Final_GMID3 2_Panels txt
[ authentiFier_GMID3 2_analysisMethod xmi

My Recent D...
(1

Desktop

4

My Documents

o B
<

My Computer

-

-«

My Network ...

File name: ;Aulherif iler_Final_GMID3.2_bins txt

Files ot type: }Al Files

LICancell

7. View the imported panels in the navigation pane:

a.

‘> panel Manager
Fle Edt B View

Double-click the AuthentiFiler_Final folder to view the
AuthentiFiler_panel_Final folder.

Double-click the AuthentiFiler_panel_Final folder to display the panel
information in the right pane.

B 3 || 1 || | [ forererior e et ) | NS |

E-SPared

E Manager L
S-S AadtertFer_Final
| ] AuthertFier_pand |

|Mighow Mama  |Dys Colr  Min Sim | Max Sim | Congrol Al Mk | ek ! Commants |Ladter Allsler

1 [DI0S1248  [blue TO.0 1270 M2 4 04094 [none 18.3,10,11 321314151617
2 [o151656 bhue 1450 (2000|1306 4 04276 [none 9,00,11,12,13,14,14.3,1515
3 [AawEL gresn (970 1055 |"xy 5 00 [none LA

4 |DFS1¥Em green 109 1789 Ao 4 0115 [none 1806,17,1819,20,2 2333,
5 |DEXE1045 yelorer T40 1160 11 16° 3 01549 |m LE-RE RN FRERERERT-RES
6 |D13S433 lebow (1180|1680 |1415 4 01024 [none 840110212 243,03 204,
7 | lyebow (1720 (22500 |785F 4 00426 [nane 4.557825310,01,133
8 [oesan e 720 134 |1eaF 0 00565 [none 9,00,11,11 312,1314,15,16
9 0651043 red [118e  [mas  Frzaee 4 0.0296 | none 8.40,11,1213,14.151617.1
10 [orz5an red |22z [zr0 [teasr 4 01367 [none 14,105,167 18,19,19.3.20,2
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8. Select D10S1248 to display the Bin view for the marker in the right pane.

(#Panel Manager
Fie Edt Bins Yiew

Ex|nmw I%!m s P o<1 [ I B8 0 8 W[ [ ]
E-ED AuthertiFler_Final =

L"J-EM&'? - 7 3 2 100 1] 2l el 16l sl (el 7l [l [19] 20

C1S1658
AMEL

0251338 o
02251045
Cr195433 08
THX
025441

- DES1043 ] or
125391

| —| ;l;, o
— EdReterence Samples i

=] 73 W & a5 ] a3 a7 M 105 109 113 1T 1A 125 129

D10S1248
Kl | |
¢ 97.34 Y.0.74 |

ok | concel | apoy |

9. Click Apply, then OK to add the AuthentiFiler" Kit panel and bin set to the
GeneMapper® ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels and
bins are not imported into the GeneMapper® ID Software database.
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4 Chapter 4 Data Analysis
Set up GeneMapper® ID Software for data analysis

Create an analysis Use the following procedure to create an HID analysis method for the AuthentiFiler™

method Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

(@] GeneMapper Manager |
Projects Analysis Methods | Table Setings | Plot Seftings | Matrices | Size Standards |

[Marne Last Saved ner Instrurment Analysiz Type Descrip
HID_Advanced 2009-06-18 16:22:2 | gmid HIDx =
HID_Clazsic 2007-08-06 10:03:0 | grmid HICx

Microsatelite Default 2004-05-28 11:34:3 | amid Microsatellite Factory)
| I I |

ey Cpen... Save Az Irport... Expart... Delete |

Done |

2. Select the Analysis Methods tab, then click New to open the New Analysis

Method dialog box.

3. Select HID and click OK to open the Analysis Method Editor with the General tab

selected.

Enter the settings shown in the figures on the following pages.

4. After you enter settings in all tabs, click Save.

General tab analysi Method Editor -0 L X

settings General | alleie | Peak Detector | Peak Qualty | Quaity Fiags |
Analysis Method Description -
Marme: IALAherdiFiIer_AnalysisMelMd
Descriptior: f]
|
Instrument: |
Analysis Type: HID

Ll Camedl

In the Name field, either type the name as shown or enter a name of your choosing.

The Description and Instrument fields are optional.
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Allele tab settings x
General Allele | peak Detector | Peak Quaity | Guaity Fiags |
BinSet  [AuthentiFiler_bins_Final =l
[V Use marker-specific stutter ratio if available
Marker Repeat Type : Tri Tetra Penta Hexa
Cut-off Value loo jo.0 joo Joo
MinusA Ratio joo oo oo o0 %
MinusA Distance From |0.0 jo.0o jon Jon =
7o [oo [0 [oo [o.0 =
Minus Stuter Ratio 0.0 oo joo joo =
Minus Stutter Distance  From  [2.25 3.25 joo joo ‘-'i@
To [375 ja.75 joo Joo 5
Plus Stutter Ratio loosssa oo joo Jon o
Plus Stutter Distance ~ From  [2.23| jo.0 jo.0 loo S
To [375 oo joo joo _ 2
: @
Amelogenin Cutoff W
Range Fiter ... I Factory Defautts

* In the Bin Set field, select the AuthentiFiler_bins_Final bin set imported
previously and configure the stutter distance parameters as shown.

* GeneMapper® ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

* The “Use marker-specific stutter ratio if available” check box is selected by
default. Consequently, the software applies the stutter ratio filters supplied in the
AuthentiFiler_Final GMID3.2_Panels.txt file. GeneMapper® ID Software v3.2.1
specifies locus-specific filter ratios for minus stutters, but not for -2 nt and plus
stutters, in the panel file. However, validation studies with the AuthentiFiler™ Kit
show that the trinucleotide repeat D2251045 locus produces a relatively large
amount of plus stutter compared to tetranucleotide repeat loci. The relatively
large amount of stutter may cause the stutter peak to be labeled during routine
analysis.
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Plus stutters were also observed for the loci D1051248 and D151656. Additionally,
and -2 nt stutter was also observed at the D151656 locus. The stutter percentages
observed during internal validation is reported in the stutter table in Chapter 5.

Users are asked to take note of these stutter percentages when analyzing data and
follow laboratory guidelines to determine if an allele peak located in a plus stutter

Peak Detector tab

settings

36

position can be discarded as a stutter peak.

* The plus stutter at the D2251045 locus can be filtered by assigning a global plus
stutter filter for trinucleotide repeat loci in the Analysis Parameter file. Because
D2251045 is the only trinucleotide repeat locus in the AuthentiFiler' " Kit, this
stutter filter setting is applied only to plus stutter peaks at the D2251045 locus.
The settings shown above resulted in little or no labeling of D2251045 plus stutter
peaks during our validation studies. Perform internal validation studies to
determine the settings to use in your laboratory.

Note: Plus stutter values for tetranucleotide repeats based on stutter percentages
for D105S1248 and D151656 were not included in the allele tab, as this will interfere
with data analysis at other tetranucleotide loci in the multiplex.

Note: We do not recommend the use of a global filter for analysis.

Analysis Method Editor - HID ol i

Gereral | Allele Peak Detector | peak Quaity | Gualty Flags |

Peak Detection Algorithm: |Advanced e l

x|

‘Ranges- | -Peak Detection Port.
. o erform
Analysis ol Sizing = Pesk Ampltude Thresholds: internal
Full Range e All Sizes > K .
_1. _ rm- | - B: 50| R: f50 validation
SAlELE | G: Js0 o: Js0 studies to
"_-t-'.f,-h.l 10000 m determine
Smoothing and Baselining settings
: Min. Peak Half Width: |2 pts
Smoothing " None
& Light Polynomial Degree; |3
" Heavy Peak Window Size: |15 pts
! . Threshold
BaselneWindow: |51 pis Bpe
Peak Start: |0-ﬂ
~Size Caling Method

" 2nd Order Least Squares
¥ 3rd Order Least Squares
" Cubic Spline Interpolation
" Local Southern Method
" Global Southern Method

Peak End: IB.U

Factory Defaults ]

O | Cancel |

IMPORTANT! Perform the appropriate internal validation studies to determine the
peak amplitude thresholds for interpretation of AuthentiFiler" Kit data.
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Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of
these peaks.

* Size calling method — The AuthentiFiler"" Kit has been validated using the 3td
Order Least Squares sizing method in combination with the GeneScan"" 500 LIZ®
Size Standard or the GeneScan™ 600 LIZ® Size Standard v2.0. Select alternative
sizing methods only after you perform the appropriate internal validation
studies.

Peak Quality tab ey ——— |

)
®
>
o
=
Q
e}
O
@
<)
)
w
[©]
=
=
Q
=
(0]

settings General| Alile | Peak Detector Peak Quaity | quaity Flags |

[ el N ~
| Homozygous min peak height Perform
| ; v internal
| S ilintonds validation
[Heterozygote balance - 3 studies to
| Min peek heihtrato o7 determine
L | settings
~Peak morphology

Ma: peak width (basepairs) |1 5

Pull-up peak

Pull-up ratio 0.05

-Allele number

Max expected alleles [2

Factory Defaults l

Ll Cancel |

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds and the minimum
peak height ratio threshold that allow for reliable interpretation of AuthentiFiler Kit
data.
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Quality Flags tab P T

settings General | Alele | Pesk Detector | Peak Qualty Quelty Fiags |
Guality weights are between 0 and 1.
Guality Flag Settings —
Spectral Pull-up ID_B Control Concordance |1 ]
Broad Peak |0.3 Low Peak Height |n.3
Out of Bin Allele [os Oft-scale |°-3
Ovstioe |n.a Peak Height Ratio |u.3
-P@V Thresholds 1
Pass Range: Low Quality Range:
Sizing Quality: From IU-?S to10 From 0.0t |0.25
Genotype Quality: From |0.75 1.0 From00to [025
Factory Defaults I

ok | _ corce

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values to use in your laboratory.

The size standards for the AuthentiFiler'" Kit uses the following size standard peaks in
their definitions:

Create a size
standard

GeneScan™ 600 LIZ® Size Standard v2.0

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, and 400

GeneScan™ 500 LIZ® Size Standard

75,100, 139, 150, 160, 200, 300, 350, 400, and
450

Note: The 250-nt and the 340-nt peak are not included in the GeneScan"" 500 LIZ® Size
Standard definition, though present in the reagent formulation. These peaks can be
used as an indicator of precision within a run.

Use the following procedure to create the size standard for the AuthentiFiler' " Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

E:;GeneMapper Manager

Mewy. .

| (0=}

SEVE AT

Import...

Expart..

Projects | Aralysis Methods | Table Settings | Piot Settings | Matrices
Matrne |Las{ Saved !Owner Type |Desc:rip‘ti0n
377 _F_HID_GS500 2004-05-28 11:34:3 | graicd Basiciidvanced Factory Provided | =
CE_G5_HID_GS500 2004-05-28 11:34:3 | grnicd Basiciidvanced Factory Provided
CE_F_HID_G=500 2004-05-25 11:34:3 | gricd Basiciidvanced Factory Provided |

Lielete |

Dore | |
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2. Select the Size Standards tab, then click New.

3. Enter a name as shown below or enter a name of your choosing. In the Size
Standard Dye field, select Orange. In the Size Standard Table, enter the sizes
specified in on page 38. The example below is for the GeneScan"" 600 LIZ® Size
Standard v2.0.

(#)size Standard Editor x|
Edit o
- Size Standard Description - (‘:D
Name: GSE00LIZ_B0-400 %
)
Descripti =
cription:
@
)
Size Standard Dye: forange =1 S
~Size Standard Table- COIJ
[Size in Bazepairs g
|'1 0.0 -] D
L (0]
2 |800
3 |1000
4 1140
s [1200 -
6 [1400
7 1600
& [180.0
g9 (2000
10 2140 M

OK Cancel I

Analyze and edit sample files with GeneMapper® ID Software
1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above.

Parameter Settings

Sample Type Select the sample type.

Analysis Method | AuthentiFiler_AnalysisMethod (or the name of the analysis method
you created)

Panel AuthentiFiler_panel_Final
Size Standard GS600LIZ_60-400 (or the name of the size standard you created)

For more information about how the Size Caller works, refer to the ABI PRisM®
GeneScan® Analysis Software for the Windows NT® Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617). For additional
information about size standards, refer to the GeneMapper® ID Software Version 3.1
Human Identification Analysis User Guide (Pub. no. 4338775).
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3. Click I» (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

¢ The status bar displays the progress of analysis as both:

— A completion bar extending to the right with the percentage completed
indicated

— With text messages on the left

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

* The Genotypes tab becomes available after analysis.

(@ )GeneMapper ID v3.2.1 - AuthentiFiler_¥TS_Performance 091812 - gmid Is Logged In F =0 x|

Fie Edt Anslysis View Tooks Help :
eh e |8 | L || OO I E|  @ | e seng| (o ssermaoe Fieene <[ || B 8| &

E-EProject Samples. | m}
}3 BM"EV"‘EZE Status [Sempie File Sample Name _[Sample Type | Analysis Method _[Panel SzeStanders |
‘;}_ux::;ﬂg 1 I |AuthentFier-pert [AL | Alleic Lacider | Authentiler_anaiysis Method [AuiheriFier_panel Fral |GSSUOLIZ (50-400) -]
- AutheriiFie |2 I |AuthentFier-perf |AL Allelic Ladder | AuthentiFiler_Analysis Method | &uthentiFier_panel_Final | GSE0OLIZ (30-400)
E-[AuthertiFie |3 I |AuthentFier-pert gDNATO " [Sampie " |AuthentiFier_Analysis Method | AutheritiFier_panel Fnal | GSB00LIZ (80-400)
-] AuthentiFiie | I |AuhentFier-pert GDNATT Sample AuthentiFiler_Analysis Method | AutheriiFier_pansl_Fmal GSE00LIZ (80-400) |||
5 P |AuthentFierpert [gDNA1Z Sample AuthertiFiler_Anslysis Method | AuthertiFier_panel_Final GSBO0LIZ (B0-400)
5 I |AuthentFier-pert [gDNATS Sample AuthentiFiler_Analysis Method | AuthertiFler_panel_Final GSE00LIZ (80-400)
7 I |AuhentFierperf | gDNATS Sample [SuthentiFiler_Analysis Method | &uthentFier_panel_Final | GSE0OLIZ (30-400)
5 I |AuthentFier.pert | GDNAT Sample (AuthertiFiler_gnalysis Method | AutherliFier_panel_Final | GSS00LIZ (80-400)
3 I% |PuthercFier-pert |gDNAZ Sarmple Authentiier_Analysis Method | AuthertiFder_panel_Fmal | GSBUOLIZ (80-400)
10 Ix  |Authentiier-pert [gDNAS Sample AuthertiFiler_Analysis Method | AuthertiFier_panel_Final GSBOOLIZ (B0-400)
11 (13 AuthentiFier-pert | gDNAY Sample AuthertiFiler_Analysis Method | AuthertiFiler_parel_Final GSEO0LIZ (B0-400)
12 |y |AuthentFierpert [gDNAS Sample [AuthentiFier_Anatysis Method | &uthentiFier_panel_Final | GSE00LIZ (30-400)
13 |y |AthentFierperf [gDNAS Sample (AuthertiFiler_gnalysis Method | AutherfiFier_panel_Final | GSSO0LIZ (80-400)
14 | | Authentiier-perf GDNAT Sample AuthertFier_Analysis Method | Authentiier_panel_Fral | GSBOOLIZ (80-400)
15 P |AuthentFierpert [gDNAS Sample AuthertiFiler_Anslysis Method | AuthertiFier_panel_Final GSBOOLIZ (80-400) |
16 (L3 AuthentiFier-pert | gDNAS Sample AuthertiFiler_Anahysis Method | AuthentiFiler_panel_Final GSBO0LIZ (B0-400) j
=] i | 7 I C
Analysis Completed. [ JE T3 |

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper® ID Software features, allele filters, peak detection
algorithms, and project editing, refer to:

*  GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Pub. no. 4335523)

*  GeneMapper® ID Software Version 3.1 Human Identification Analysis User Guide
(Pub. no. 4338775)

o Installation Procedures and New Features for GeneMapper® ID Software Version v3.2
User Bulletin (Pub. no. 4352543)
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Overview of GeneMapper® ID-X Software

GeneMapper® ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the Data Collection Software stores information for each sample
in an .fsa file. Using GeneMapper® ID-X Software v1.0.1 or higher, you can then
analyze and interpret the data from the .fsa or .hid files.

Note: The .hid files can only be analyzed using GeneMapper® ID-X Software v1.2 or
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higher.

Instruments See “Instrument and software overview” on page 14 for a list of compatible
instruments.

Before you start When using GeneMapper® ID-X Software v1.0.1 or higher to perform human

identification (HID) analysis with STR kits, be aware that:

e HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.

For multiple ladder samples, the GeneMapper® ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

* Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

* Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles may

contain full and/or partial repeat units. An off-ladder allele is an allele that occurs
outside the +0.5-nt bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.

AuthentiFiler™ PCR Amplification Kit User Guide 41



4 Chapter 4 Data Analysis
Set up GeneMapper® ID-X Software for data analysis

Set up GeneMapper® ID-X Software for data analysis

File names The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com.

Overview To analyze sample (.fsa) files using GeneMapper® ID-X Software v1.0.1 or higher for
the first time:

1. Import panels, bins, and marker stutter into the Panel Manager, as explained in
“Import panels, bins, and marker stutter” below.

2. Create an analysis method, as explained in “Create an analysis method” on page
47.

3. Create a size standard, as explained in “Create a size standard” on page 52.

4. Define custom views of analysis tables.

Refer to the GeneMapper® ID-X Software Version 1.0 Getting Started Guide
(Pub. no. 4375574) for more information.

5. Define custom views of plots.

Refer to the GeneMapper® ID-X Software Version 1.0 Getting Started Guide
(Pub. no. 4375574) for more information.

Import panels, To import the AuthentiFiler " Kit panels, bin sets, and marker stutter from
bins, and marker www.lifetechnologies.com into the GeneMapper® ID-X Software database:
stutter 1. Download and open the file containing panels, bins, and marker stutter:

a. From the Support menu of www.lifetechnologies.com, select
Support » Software Downloads, Patches & Updates » GeneMapper® ID-X
Software » Updates & Patches, and download the file AuthentiFiler
Analysis Files GMIDX.

b. Unzip the file.

2. Start the GeneMapper® ID-X Software, then log in with the appropriate user
name and password.

IMPORTANT! For logon instructions, refer to the GeneMapper® ID-X Software
Version 1.0 Getting Started Guide (Pub. no. 4375574).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

#* Panel Manager
File Edit Bins View Help

> i
c. Navigate to, then open the AuthentiFiler Analysis =SB —

Files GMIDX folder that you unzipped in step 1 R hancitnacer
of this section.

b. Select File » Import Panels to open the Import
Panels dialog box.
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Set up GeneMapper® ID-X Software for data analysis

5. Select AuthentiFiler_Final_Panels.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “AuthentiFiler_Final”. This folder contains the panel and associated

markers.
S mport Paneley A
Lookin: |5 AuthentiFier [~ A= =
) [Z] AuthentiFiler_Final_bins.txt
L‘\b 8 AuthentFier_Final Panels.tit
My Recent [£] AuthentiFiler_Final_stutter txt
Documents
Desktop
My Documents
Computer
Q File name: AuthentiFiler_Final_Panels,txt Import
My Network
Places Files of type: | All Files =

6. Import AuthentiFiler_Final bins.txt:

a. Select the AuthentiFiler_Final folder in the navigation pane.

 File Edt Bins View Help

i X | B ™ BinSet: AuthentiFiler_bins_Final @
= g5y Panel Manager Gl | [Pamel Nene Comment

1 FuthentiFiler _panel_Final |.null

8 (W AuthentiFiler_Final

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the AuthentiFiler Analysis Files GMIDX folder.
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d. Select AuthentiFiler_Final_bins.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AuthentiFiler_Final folder.

S rr—— = ;
Lookin: |(C3) AuthentiFiler L’ ,’EE
-
L@ AuthentiFiler_Final_Panels.txt
My Recent [£] AuthentiFiler_Final_stutter.txt
Documents
Desktop
My Documents
My Computer
Filename:  |AuthentiFiler_Final_bins.txt | [ mpot |
My Network =z,
Places Files of type: | Al Files =2 [ Cancel ]

7. View the imported panels in the navigation pane:
a. Double-click the AuthentiFiler_Final folder.

b. Double-click the AuthentiFiler_panel Final folder to display the panel
information in the right pane and the markers below it.

Fle Edt Bra View Help m
X B E | B ™ ense: ehenrier bos Fna g WaEE EEEEEEE o
[= &rs T | (MekwHem Dy Cobr Mn dim [Mux fi | Coneal Al [rpr— Ludder Al
S o authentiFler Fral 0 Be [0 1270 1215 4 [ronn 18,9,10,11,12,13,14,15,16,
& [ Athertiter _pand Fndl ?mm W50 E.n [EATS T rore 5,10,11,12,13,18,14.3,15,
Green [0 [055  |uy 5 |rome v
Green 1105 (1798 2,23 4 rone 15,16,17,18,19,20,21,22.2
Trelow (740 (1168 11,06 T e T IRSI011,12,15,14,15,16,
Velow [1180 (1680 18,15 4 rone 90,1212 2,13,132,1
rebow  |172.0 E.n 753 4 rone
Red 72.0 113.4 14,15 4 rone
Red  [l18.6 (2046 12,14 4 rone
Red (20 [wr0 (19 4 [rone

i Pelerence Samples

(o] [eme ] (o J[ 0 ]
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8. Select D10S1248 to display the Bin view for the marker in the right pane.
SBanel B e - .

Fis Edt Bns View Help
X § MW W] Bnser: | aheniier bos Fndd g woushs EEEEEER o

= Authentiier_Final
=3 AuthentFiar_panel_Final 4

[~]
B 01051246
®- D151656
- AMEL 05
& D2S1338
@ D2251045

@ D195433

- THOL .
& D25441
- DES1043
@ D1253%1

08

05

sBuReference Samples
04

®
D
2
D
<
Q
©
e)
o]
(©)
S
<
w
S
—
=
)
(0}

03

0z

0.
65 67 69 T TE TS T O 81 22 85 67 89 91 %2 35 4T 99 101 103 105 107 109 1191 143 115 17 119 121 123 125 127 129 1

1081248

G = =]
(Coc ] (Ccancel ] [ ponty ] [ 1eb ]

9. Import AuthentiFiler_Final_stutter.txt:
a. Select the AuthentiFiler_Final folder in the navigation panel.

5?‘ 5‘,' {JlE’ Maﬁf Jj.’g!ga_

File Edit Bins View Help i
wXxX EE B ™  BinSet: AuthentFier_bins_Final

i=

= g, Panel Manager [ Panel Name |(:ma
&) {8 AuthentiFiler Final UEhentiFier _panel_Final Jnull

-

b. Select File » Import Marker Stutter to open the Import Marker Stutter dialog
box.

c. Navigate to, then open the AuthentiFiler Analysis Files GMIDX folder.
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d. Select AuthentiFiler_Final_stutter.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the AuthentiFiler_bins_Final folder.

u? ImportMarker Stitier: @1
Lookin: |23 AuthentiFiler M 2 >EE
[Z] AuthentiFiler_Final_bins.txt
;3 [Z] AuthentiFiler_Final_Panels.txt
My Recent | B AuthentiFiler_Final_stutter.txt|
Documents
‘,—*‘.%
Desktop
My Documents
58
My Computer
;é File name: AuthentiFiler_Final_stutter txt
My Network

10. View the imported marker stutters in the navigation pane:

a. Select the AuthentiFiler_Final folder to display its list of markers in the right

pane.

b. Double-click the AuthentiFiler_panel_Final folder to display its list of

markers below it.

c. Double-click D2251045 to display the Stutter Ratio & Distance view for the
marker in the right pane.

Because D2251045 has a trinucleotide repeat unit, it produces a higher level
of plus stutter than tetranucleotide markers, and so requires the use of a plus
stutter filter. The settings for the D2251045 plus stutter filter can be seen in
the table in the right pane. In addition to D2251045, during internal
validation, plus stutters were observed for two tetranucleotide markers,
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D10S1248 and D151656. Plus stutter filters are provided in the stutter file for
these markers as well and are displayed in a table in Chapter 5. Other
markers may not require a plus stutter filter, in which case the settings for
plus stutter are left blank.

el e ]|
_F-le Edt Eins View Help
X B EE W™ Gnset: nuhentiler bins Find M HLESE BEEEEEE @

= L AuthantiFler_Fina [~]| : y : -
= (3 MithertiFler_panel_Final Please enter the stutter filter(s) for D2251045 marker here If left blank, the global stutter filter will be applied.

& DI0S1248

S Minus Stutter Plus Stutter

= D2251045 L1 2,25 375 Fm |2.25 |3.75

1
3
4

- DI95433
& THOL
& D25441

i DES1043
 vizsos

TETRT=

(@)
(0]
=}
(0]
<
QO
©°
e}
SE
)]
S
<
wn
o
=3
=
D
(0]

i 'ﬂ‘l?efe(ence Samples

11. Click Apply, then OK to add the AuthentiFiler™ Kit panels, bin sets, and marker
stutter to the GeneMapper® ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels,
bin sets, and marker stutter will not be imported into the GeneMapper® ID-X
Software database.

Create an analysis  Use the following procedure to create an analysis method for the AuthentiFiler™ Kit.
method

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X Software version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software, or with GeneMapper® ID Software version 3.2.1.
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1. Select Tools » GeneMapper® ID-X Manager to open the
GeneMapper® ID-X Manager.

»* GeneMapper® ID-X Manager

Find Mame Containing:

Marne Last Saved Qwner Instrument Analysis Type C
AmpFLSTR_AnalysisMethod _w1x 2011-02-25 09:43:0 | grid: HID | L
< ' B

2. Select the Analysis Methods tab, then click New to open the Analysis Method
Editor with the General tab selected.

3. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings (see step 4
on page 48). To complete this step quickly, do not save the analysis method until
you finish entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.

Gen_eral tab AnalysisiMetiiod Editor, a‘
settings ——
g General | Allede | Peak Detector | Peak Quality | 5Q & GQ Settings
r-#nakysis Method Description -
Name: AuthentiFiler_analysisMathod
Security Group: GeneMapper ID-X Security Group v
Description: |
=Y
|
Instrument:
Analysis Type: HID
[ Save I [ Cancel ] [ Help ]

Enter a name as shown below or enter a name of your choosing. In the Security Group
field, select the Security Group appropriate to your software configuration from the
drop-down list. The Description and Instrument fields are optional.
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Allele tab settings x|

BinSet: | AuthentiFiler_bins_Final [+

Use marker-specific stutter ratio and distance if avaiable

Marker Repeat Type: Tri Tetra Penta Hexa [0
Global Cut-off Value 0.0 0.0 0.0 0.0 g
MinusA Rakio 0.0 0.0 0.0 0.0 %
MinusA Distance From 0.0 0.0 0.0 0.0 %

To |0.0 0.0 0.0 0.0 8
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0 \®
Global Minus Stutter Distance From (0.0 0.0 0.0 0.0 |D

To |00 0.0 0.0 0.0 ;
Global Plus Stutter R atio 0.0 0.0 0.0 0.0 %
Global Plus Stutter Distance From (0.0 0.0 0.0 0.0 5

To |0.0 0.0 0.0 0.0 @
Amelogenin Cutoff i

Range Filter... Factory Defaulks

[ Save As ][ Save ” Cancel ]I Help ]

* In the Bin Set field, select the AuthentiFiler_bins_Final bin set imported
previously and configure the stutter distance parameters as shown.

* GeneMapper® ID-X Software allows you to specify four types of marker repeat
motifs: tri, tetra, penta, and hexa. You can enter parameter values for each type of
repeat in the appropriate column.

* The “Use marker-specific stutter ratio and distance if applicable” check box is
selected by default. When this box is checked, the software applies the stutter
ratio filters in the AuthentiFiler_Final_stutter.txt file.

Note: We do not recommend the use of global filter for analysis.
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Peak Detector tab

. [_;,_J_Jﬁi,fzi: gt d Edtor E‘E
settings -

| | General | Alela i[ Pask Quaity | 50 & GQ Sattings

Peak Detection Algorithm: Advanced

Ranges Peak Detection Perform
nnalhfsis Sizhg : Peak Amplitude Thresholds: internal
Full Range a |AlSizes i B [so R’ 50 validation
_ G: |50 p: |50 I studies to
i v [s0 0: 50 determine
| | -smoat hing and Baselining SettlngS
. Min. Peak Half Width: 2 pts
Smoothing () None :
@ Ught Polymomial Degree: 3
O Heavy Peak Window Size: 15 pts
| Baseline Window: 51 pts Slope Thrashold
Paak Start: 0.0
Size Calling Method Pesk End: 00
() 2nd Order Least Squares 1
(® 3rd Order Least Squares Normalization
() Cubic Spline Interpolation Use Normalization, iF applicable
O Local Southern Method &
O Global Southern Method

! Factory Defaults

[ Save As ][_ Save ” Cancel ”— Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of AuthentiFiler'" Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the
genotype of these peaks.

* Size calling method - The AuthentiFiler™ Kit has been validated using the 374
Order Least Squares sizing method with the GeneScan"" 500 LIZ® Size Standard
or the GeneScan"" 600 LIZ® Size Standard v2.0. Select alternative sizing methods
only after you perform the appropriate internal validation studies.

¢ Normalization (v1.2 or higher) — For use with 3500 data. Perform internal
validation studies to determine whether to use the Normalization feature for
analysis of AuthentiFiler'" Kit data.
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Peak Quality tab

al

settings

| General | Allele | Peak Detactor [|Peak Quaity [| 5q & 6Q Settings|

m!rﬂ.sx Peak Height (LPH/MPH)
Homozygous min peak height 200.0 Perform
Hatarazygaus min peak height 100.0 internal
Max Pesk Height (MPH) 7000.0 validation

studies to

Peak Height Ratio (PHR) determine
Min peak height ratio 0.7 settings
Broad Peak (BD)
Max peak width (basepairs) [15

Allele Mumber (AN)
Max expected alleles |2

Allelic Laddar Spike

(@)
(¢
=)
[©)
<
V)
©°
©
9;
&)
S
x
n
o
=5
£
L
(0}

Spike Detection Enable

Cut-off Value 0.2

Save As I[ Save I[ Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds, maximum peak
height threshold, and the minimum peak height ratio threshold for interpretation of
AuthentiFiler " Kit data.
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SQ & GQ tab
settings

Create a size
standard

52

Analysisietiiod kditor

| | General | Allels | Paak Detector | Paak Quality

Quality weights are between 0 and 1.

Sample and Control GO Weighting

Broad Peak (BD) 0.8 Allele Number (AN}
[|| Outof Bin ABele (BIN) 0.8 Low Peak Height (LPH)
|| Overtap (ow) 0.8 Max Peak Height (MPH)
||| Marker spike (sPK) 0.3 Off-scale (05)

Peak Height Ratio (PHR)
Control Concordance (CC) Weight = 1.0 (Only applicable to controls)
5Q Weighting
Broad Peak (BD) 0.5

Alielic Ladder GQ Weighting

||| spike (sSPK[SPK) 1 Off-seale (05)

adad

50 & GQ Ranges

1.0 From0.0to |0.25

Sizing Quality: From |0.75

i Genotype Quality: From 0.75 to1.0 FromQ.0to (0.25

i Reset Defaulks

i ISaveﬁsHSave]i{ Cancel][Hek)l

1.0
0.3
0.3
0.8
0.3

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to

determine the appropriate values to use.

The size standards for the AuthentiFiler' " Kit uses the following size standard peaks in

their definitions:

GeneScan™ 500 LIZ® Size Standard

GeneScan™ 600 LIZ® Size Standard v2.0

75, 100, 139, 150, 160, 200, 300, 350, 400, and
450

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, and 400

Note: The 250-nt and the 340-nt peaks are not included in the GeneScan"" 500 LIZ®
Size Standard definition, though present in the reagent formulation. These peaks can
be used as an indicator of precision within a run.

Use the following procedure to create the size standard for the AuthentiFiler' " Kit.

1. Select Tools » GeneMapper® ID-X Manager to open the GeneMapper® ID-X

Manager.
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2. Select the Size Standards tab, then click New.

Find Mame Containing: |

| Projects | Analysis Methods || Table Settings | Plat Settings | Matrices| Size Standards | Repart Settings |

Marme Last Saved Cwner Type Description
| CE_F_HID_G3500 (75-400) 2007-08-09 13:23:5 | gmid:x Advanced ~
CE_F_HID_G3500 (75-450) 2007-08-09 13:24:0 | gmid: Advanced _
CE_G5_HID_G5500 2006-10-11 1311212 | gmids Advanced ]
:

3. Enter a name as shown below or enter a name of your choosing. In the Security
Group field, select the Security Group appropriate to your software configuration
from the drop-down list. In the Size Standard Dye field, select Orange. In the Size
Standard Table, enter the sizes specified on page 52. The example below is for the
GeneScan™ 600 LIZ® Size Standard v2.0.

(@)
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[©)
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V)
©°
©
52
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S
x
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o
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L
(0}

#2517 Standiard Editor, x|
[
Size S andard Descriphion
Piame: GSS00LIZ_60-400
Descriphon;
Size Sandard Dye: Crange ¥}
Size Standard Table
Size in Basepars
Insert Delete
3 TN
2 |80

5 :
T

17 [3140

22 [+0.0

(o) Come J (e ]

AuthentiFiler™ PCR Amplification Kit User Guide 53



4 Chapter 4 Data Analysis
Analyze and edit sample files with GeneMapper® ID-X Software

Analyze and edit sample files with GeneMapper® ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the names you specified.

Parameter Settings
Sample Type Select the sample type.
Analysis Method AuthentiFiler_AnalysisMethod (or the name of
the analysis method you created)
Panel AuthentiFiler_panel_Final
Size Standard GS600LIZ_60-400 (or the name of the size

standard you created)

For more information about how the Size Caller works, or about size standards,
refer to the GeneMapper® ID-X Software v1.2 Reference Guide (Pub. no. 4426481).

3. Click I» (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

e The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage completed indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed upon completion of the analysis.

The figure below shows the analysis summary window after analysis.

Fle £t A Vem Toch Adun heb
Dol | &F EEOEW EED| b @ rdks o0 HE ~rE8D D

Bt supiea] v ey | Ganstoges

| Analysis Summary Summary Generstion Dsle: Sep 71, 2032 11:95:52 AN
Select run Folder to dupley; A

) totai o o s

(CIkK 3 Ik below b display 3 Bered Samples Tatle contaning sndy the sameles 1eicied
‘Allok Ladder Qualiy per run foider (based on 0 and CGQ onky)

[ ieurd mmmavens W )

‘Control Gualty per i ofect [Based on samebe POVS: SOS, SSPH. MIL OMR, 50, C68)

Coreri e | Teas oo | @ Movenamme | @ oowor e treoh v et

Sarmple Gualey par project (hased on sarple POVS: SO5, SSPK, MK OMR, S0, C64)

Tos o Sores 8 et & 0 o e O ok ot
Sarghes [ [+ 2
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Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).

For more information

For more information about any of these tasks, refer to:
e For quick set-up instructions, refer to the GeneMapper® ID-X Software Version 1.0
Getting Started Guide (Pub. no. 4375574).
* For details about GeneMapper® ID-X Software features, allele filters, peak
detection algorithms, and project editing, refer to:

—  GeneMapper® ID-X Software Version 1.0 Getting Started Guide
(Pub. no. 4375574)

—  GeneMapper® ID-X Software Version 1.0 Quick Reference Guide
(Pub. no. 4375670)

—  GeneMapper® ID-X Software Version 1.0 Reference Guide (Pub. no. 4375671)
—  GeneMapper® ID-X Software Version 1.1 (Mixture Analysis Tool) Getting Started
Guide (Pub. no. 4396773)

—  GeneMapper® ID-X Software Version 1.1 (Mixture Analysis Tool) Quick Reference
Guide (Pub. no. 4402094)

—  GeneMapper® ID-X Software Version 1.2 Quick Reference Guide
(Pub. no. 4426482)

—  GeneMapper® ID-X Software Version 1.2 Reference Guide (Pub. no. 4426481)
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Section 4.3 GeneMapper® Software

Overview of GeneMapper® Software

GeneMapper® Software is a flexible genotyping software package that provides DNA

sizing and quality allele calls for all Applied Biosystems® electrophoresis-based o)
genotyping systems. 2
<
After electrophoresis, the Data Collection Software stores information for each sample £z
in an .fsa file. Using GeneMapper® Software v4.1, you can then analyze and interpret 8
the data from the .fsa files. 0(?
2
Instruments See “Instrument and software overview” on page 14 for a list of compatible )
instruments. ®
Before you start When using GeneMapper® Software v4.1 to perform human identification (HID)

analysis with STR kits, be aware that:

¢ HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.
For multiple ladder samples, the GeneMapper® Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run.
When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

e Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type

column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

¢ Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR® Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.
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Set up GeneMapper® Software for data analysis

File names The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.lifetechnologies.com.

Overview To analyze sample (.fsa) files using GeneMapper® Software v4.1 for the first time:

1. Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” below.

2. Create an analysis method, as explained in “Create an analysis method” on page
61.

3. Create a size standard, as explained in “Create a size standard” on page 66.

4. Define custom views of analysis tables.

Refer to the GeneMapper® Software Version 4.1 Getting Started Guide for Microsatellite
Analysis (Pub. no. 4403672) for more information.

5. Define custom views of plots.

Refer to the GeneMapper® Software Version 4.1 Getting Started Guide for Microsatellite
Analysis (Pub. no. 4403672) for more information.

Import panels and  To import the AuthentiFiler™ Kit panel and bin set from www.lifetechnologies.com
bins into the GeneMapper® Software v4.1 database:

1. Download and open the file containing panels and bins:

a. From the Support menu of www.lifetechnologies.com, select
Support » Software Downloads, Patches & Updates » GeneMapper®
Software v4.1 » Updates & Patches, and download the file AuthentiFiler
Analysis Files GM4.1.

b. Unzip the file.

2. Start the GeneMapper® Software, then log in with the appropriate user name and
password.

IMPORTANT! For logon instructions, refer to the GeneMapper® Software Version 4.1
Getting Started Guide for Microsatellite Analysis (Pub. no. 4403672) for more
information.

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels and bins:

a. Select Panel Manager in the navigation pane.

e Panel Manager

b. Select File » Import Panels to open the Import B (Ohs Vi

Panels dialog box.

c. Navigate to, then open the AuthentiFiler Analysis
Files GM4.1 folder that you unzipped in step 1
above.

o, Panel Manager
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Set up GeneMapper® Software for data analysis

5. Select AuthentiFiler_Final_Panels_GM4.1.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “AuthentiFiler_Final”. This folder contains the panel and associated

markers.
@ Import Panels E]
Lookin: | AuthentiFiler GM4.1 v TEE

@

) :Q AuthentiFiler_Final_bins_GM4.1.txt g

& B AuthentiFiler_Final_Panels_GM4.1,txt %

My Recent [
Documents %

@

3
€ ]

L$ n

o

Desktop g

=

®

My Documents

P

My Computer

Q File name: jAuthentiFiIer_Final_Panels_G\H‘ 1.kxt | Import I
My Network o :
Places Files of type: | all Files v | Cancel |

6. Import AuthentiFiler_Final_bins_GM4.1.txt:

a. Select the AuthentiFiler_Final folder in the navigation pane.

File Edit Bins View
> o N B8 Bin Set: | AuthentiFiler_bins_Final

= ;5 Panel Manager Panel Name 'Comment
38 (W 2 thentiFiler_Final 1 [Quthentﬂer _panel_Final I‘m“e

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the AuthentiFiler Analysis Files GM4.1 folder.
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d. Select AuthentiFiler_Final_bins_GM4.1.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
AuthentiFiler_Final folder.

B authentiFiler_Final_bins_GM4.1.kxt
KZ 2] AuthentiFiler_Final_Panels_GM4.1.txt

My Recent
Documents

My Documents

.

My Computer

-

File name: iﬂh;ﬁti_ﬁie_r;Find_blm_GMZi_.&t

[ import

My Metwork

|

|

les of type: ? |

Places Files of type: | all Files v

’ Cancel

7. View the imported panels in the navigation pane:

a. Double-click the AuthentiFiler Final folder.

b. Double-click the AuthentiFiler_panel_Final folder to display the panel

information in the right pane.

Fle Edt Bins View
E@ X WWEE EE anse: ahenfir bins Fndl v/ LT EE BEEEEEEN
= gy Parel Managar Univeral | Mader Nams | Dys Cobe |iin Size M Size | Costiol Allales Maker Madar |Analysis Mashed Commants
= CauthentFer_Final L [_Jowsiess (e [mo 1270 1215 4 01094 |AutherkiFder Andyss 1 |none
= 2 D151656 e 1450 2000 (13,16 4 0.1276 AutherkFler Anabysis | none
3 AMEL Green  [97.0 1055 |ny I 0.0 |AuthertiFler Anghyss | |nore
4 o1 (Geen (1105 (1799 223 4 (0015 |AuthentFier Andhyss 1 |none
s | DZZS1045  [Yebow (740 (1160 11,16 3 [0.1649 [Authertiier Andysis 1 |none
n 195433 Velow [118.0 (1680 14,15 4 01024 |AutherkiFer Andyss 1 |none
7| THOL Velow (1720 (2250 (7,93 “ 0.0426 AutherkFder Andlyss 1 |none
& D241 Red (720 [1134  [14,15 I 0.0865 | AuthertiFles Anghyss | |nore
9 | DES1043 Red (1186 |2046 (12,14 I [0.0996 [AutherktiFler Ansrsis 1 [nore
10 D1Z5391 Red (@20 |70 18,19 4 [0.1367 Autheckider Andbris 1 none
3 ¥
R &
sl Reference Samples
=)
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8. Select D10S1248 to display the Bin view for the marker in the right pane.

B Panel Manager

B X (i W B W et | RuthentFle_bins Fia + IR EGE EEEEEEN

= gy Parel Manager
&' T s 9 10 11 12 13 19 15 1 17 18 19 20

~
| %

®
(0]
2
(0]
<
Q
©
e}
@
(©)
w
o
=1
s
)
(0]

[L1

LY
B O 8 H M MW M N oH B 8 M B N ¥ ¥ N B dn W 03 W o M iR 83 M 1 i iR 18 T B

—

1051238
|$ .
|1 70.90 ¥ 0.50 Bin: 7(70.10-71.10) Marker 01051248 (70.00-127.00)

(Coc ] (Camee ] (oo

9. Click Apply, then OK to add the AuthentiFiler"™ Kit panel and bin set to the
GeneMapper® Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the panels
and bins are not imported into the GeneMapper® Software database.

Create an analysis  Use the following procedure to create an HID analysis method for the AuthentiFiler™
method Kit.

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created for
GeneMapper® ID-X Software version 1.2 is not compatible with earlier versions of
GeneMapper® ID-X Software, or with GeneMapper® ID Software version 3.2.1.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.
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3. Select HID and click OK to open the Analysis Method Editor with the General tab

selected.
New Analysis Method E]
Select analysis type:
@ Mic () OLA Analysis ) AFLP
() SNaPshot® () SNPlex Model 3730

() ShPlex Rules 3730 () SNPlex Rules 3130

[ OK J[ Cancel ]

Enter the settings shown in the figures on the following pages.

4. After you enter the settings on all tabs, click Save.

General tab

Analysis Method Editor - Microsatellite

Settl n gs General _Allele | Peak Detector I Peak Qualit_s_f 1 ggali_t_y_fl\_agf |
rAnalysis Method Description

Mame: :Auﬂ‘nentiFiIer_MaIysisMatI‘sod|

Description: |
=a|
|

Instrument:

Analysis Type: Microsatelite

In the Name field, either type the name as shown or enter a name of your choosing.
The Description and Instrument fields are optional.

62 AuthentiFiler™ PCR Amplification Kit User Guide



Section 4.3 GeneMapper® Software

Set up GeneMapper® Software for data analysis

Auel‘e tab Settings Analysis Method Editor - Microsatellite

| General || Alele | peak Detector | Peak Quality | Qualty Flags |

BinSet: | AuthertiFler_bins_Final v
Marker Repeat Type

Use marker-specific stutter ratio if avaiable

Wahues for dinuclectide repeats are calculated automatically.

Mono Tri Tetra Penta Hexa
Cut-off value 0.0 0.0 0.0 0.0 0.0
r @
Plusa ratio 0.0 0.0 0.0 0.0 0.0 (31)
@
Plusa distance 0.0 0.0 0.0 0.0 0.0 z
: 3 5 5 Q
Stutter ratio 0.0 0.0 0.0 0.0 0.0 °
' ?
Stutter distance From [0.0 0.0 0.0 0.0 0.0 1@
To 0.0 3.5 4.5 5.5 6.5
o
=1
=
)
@
Range Filter... Factory Defaults

(=) =)

* In the Bin Set field, select the AuthentiFiler_bins_Final bin set imported
previously and configure the stutter distance parameters as shown.

* GeneMapper® Software v4.1 allows you to specify four types of marker repeat
motifs: tri, tetra, penta, and hexa. You can enter parameter values for each type of
repeat in the appropriate column.

¢ The “Use marker-specific stutter ratio and distance if applicable” check box is
selected by default. Consequently, the software applies the stutter ratio filters
supplied in the AuthentiFiler_Final_Panels_GM4.1.txt file. GeneMapper®
Software v4.1 specifies locus-specific filter ratios for minus stutters, but not for
plus and -2 nt stutters, in the panel file.

However, validation studies with the AuthentiFiler™ Kit show that the
trinucleotide repeat D2251045 locus produces a relatively large amount of plus
stutter compared to tetranucleotide repeat loci. The relatively large amount of
stutter may cause the stutter peak to be labeled during routine analysis. Plus
stutters were also observed for the loci D1051248, and D151656. Additionally, and
-2 nt stutter was also observed at the D151656 locus. The stutter percentages
observed during internal validation is reported in the stutter table in Chapter 5.

Users are asked to take note of these stutter percentages when analyzing data and
follow laboratory guidelines to determine if an allele peak located in a plus stutter
position can be discarded as a stutter peak.

Note: Plus stutter and -2 nt stutter (D151656 only) values for trinucleotide and
tetranucleotide repeats based on stutter percentages for D2251045, D1051248, and
D151656 could not be included in the panel file due to functional limitations in
the software.

Note: We do not recommend the use of global filter for analysis.
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Peak Detector tab
settings

64

Analysis Method Editor - Microsatellite

Peak Detection Algorithm: | Advanced

Ranges
Analysis Sizing
Full Range v Partial S... (¥
Start Size:|60 |
| Stop Size: 400

Smoothing and Easelining

Smaothing () None
O Heavy
Baseline Window: |51 pts

Size Calling Method
() 2nd Order Least Squares
() 3rd Order Least Squares
() Cubic Spline Interpolation
() Local Southern Method
() Global Southern Method

| General | Allele | Peak Detector | peak Quality | Quality Flags

~

Peak Detection
Peak Ampltude Thresholds:
B: |50 R |50
G: |50 p: 50
Y: |50 0: |50
Min. Peak Half Width: |2 pts
Polynomial Degres: 3
Peak Window Size: 15 pts
r~Shape Threshald
Peak Start: 0.0
Peak End: 0.0

Size Standard Normalization

[] Enable Mormakization

Mobe: For 354X series
data collection
niormalization only.

Factory Defaults

=)

Perform
internal
validation
studies to
determine
settings

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of AuthentiFiler'" Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper® Software displays peaks that fall below the specified amplitude in
electropherograms, the software does not label or determine the genotype of these

peaks.

* Size calling method — The AuthentiFiler " Kit has been validated using the 3'd
Order Least Squares sizing method with the GeneScan'" 500 LIZ® Size Standard
or the GeneScan"" 600 LIZ® Size Standard v2.0. Select alternative sizing methods
only after you perform the appropriate internal validation studies.
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Peak Quality tab

Settings Analysis Method Editor - Microsatellite
| General | Allele | Peak Detector | Peak Qualty | Qualty Flags

Signal level Perform
Homozygous min pesk height 2000 | internal

Heterozygous min peak height (100.0 validation
studies to
Heterozygote balance determine
Min peak helght ratio s | settings

Peak morphaology
Max peak width (basepairs) 1.5

rPull-up pesk-
Pull-up ratio 0.1

Pull-up scan 1

Allele rumber
Max expected alsles 2

®
(0]
2
(0]
<
Q
©
e}
@
(©)
w
o
=1
s
)
(0]

rCross-talk paak
Cross-talk ratio 0.05

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds, maximum peak
height threshold, and the minimum peak height ratio threshold for interpretation of
AuthentiFiler ™ Kit data.
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SQ & GQ tab
settings

Create a size
standard

66

Analysis Method Editor - Microsatellite

General| Allele | Peak Detector | Peak Qualty | Quality Flags

Quality weights are between 0 and 1.

Quality Flag Settings
Spectral Pull-up (SPU) 0.3 Control Concordance (CC) 1.0
Broad Peak (BO) 0.8 Low Pesk Height (LPH) 0.3
Single Peak Artifack (SPA) 0.5 Off-scale (05) 0.8
Sharp Pesk (SHP) 0.5 Peak Height Ratio (PHR) 0.3
Cross Talk (XTLK) 0.5 One Basepair Allele (OBA) 0.5
Out of Bin Allele (BIN) 0.8 Splt Peak (5P) 0.5

-PQW Thresholds

Pass Range: Low Quality Range:

Sizing Quality: From _0.?5 ko 1.0 From0.0to |0.25
Genotype Quality: ~ From 10,75 to1.0 From0.0ts  |0.25

Assume Linearity From {bp): |0 To (bp}: 800

Factory Defaults

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to

determine the appropriate values to use.

The size standards for the AuthentiFiler"" Kit uses the following size standard peaks in

their definitions:

GeneScan™ 500 LIZ® Size Standard

GeneScan™ 600 LIZ® Size Standard v2.0

75,100, 139, 150, 160, 200, 300, 350, 400, and
450

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, and 400

Note: The 250-nt and the 340-nt peaks are not included in the GeneScan™ 500 LIZ®
Size Standard definition, though present in the reagent formulation. These peaks can
be used as an indicator of precision within a run.

Use the following procedure to create the

size standard for the AuthentiFiler™ Kit.

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
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Set up GeneMapper® Software for data analysis

2. Select the Size Standards tab, then click New.

eMapper Manager

gmid Basic/Advanced 2009-10-10 by AGCU

GSE0OLIZ_60-400 |Orange 2012-04-27 09:52:46.0 |gm Basic/Advanced

ShPlex_4plex_v1 |Orange 2003-09-26 11:16:34.0 |gm Basic/Advanced Factory Provided

GSE00LIZ Orange 2008-06-27 11:03:44.0 |gm Basic/Advanced Factory Provided

GSE00LIZ+Normalization  |(Orange Z008-06-27 10:59:54.0 |gm BasicfAdvanced Factory Provided i

GSSO0ROY [Red 2008-04-17 14:58:46.0 |gm Basic/Advanced Factory Provided | (GD)

G5500(-35,-250,-340)ROX 'EREU 2008-06-11 17:04:14.0 |gm Basic/Advanced Factory Provided 8

GS500{-35,-250,-340)L1Z |Orange 2008-04-17 14:59:07.0 |gm Basic/ Advanced Factory Provided <

GS500{-250)ROK [Red 2008-04-17 14:56:15.0 |gm Basic/Advanced Factory Provided %

GSS00{-250)LIZ :iorme 2002-08-20 13:02:36.0 \gm Basic/Advanced Factory Provided 8

GSA00HDROK ;-Red 2002-08-20 13:02:36.0 |gm Basic/Advanced Factory Provided _‘®

GSF50R0OY Red 2002-06-10 14:26:47.00 |gm Basic/Advanced Factory Provided wn

G5120L1Z [Orange 2002-08-20 13:02:36,0 \gm Basic/Advanced Factory Provided %

G51200L1Z |Orange 2008-08-11 16:39:54.0 |gm Basic/Advanced Factory Provided =

4 . | o %
[(Wew.. | [ open.. | [ Savess.. | [ mmport... | [ Export..

3. Enter a name as shown below or enter a name of your choosing. In the Security
Group field, select the Security Group appropriate to your software configuration
from the drop-down list. In the Size Standard Dye field, select Orange. In the Size
Standard Table, enter the sizes specified on page 66. The example below is for the
GeneScan™ 600 LIZ® Size Standard v2.0.

oW Size Standard Editor

Edt -
—Size Standard Description
Name: G5600LIZ_60-400
Description:
Size Standard Dye: Orang_e v'
Size Standard Table -
= 0 Besopas [ mnset || Delete |
1 p0.0 A
2z |80.0
3 |100.0
4 |114.0
S |120.0
6 |140.0
7 |160.0
8 |180.0 fe-
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Analyze and edit sample files with GeneMapper® Software

Analyze and edit sample files with GeneMapper® Software

68

1.

In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the names you specified.

Parameter Settings
Sample Type Select the sample type.
Analysis Method AuthentiFiler_AnalysisMethod (or the name of
the analysis method you created)
Panel AuthentiFiler_panel_Final
Size Standard GS600LIZ_60-400 (or the name of the size

standard you created)

For more information about how the Size Caller works, refer to the ABI PRisM®
GeneScan® Analysis Software for the Windows NT® Operating System Overview of the
Analysis Parameters and Size Caller User Bulletin (Pub. no. 4335617). For additional
information about size standards, refer to the GeneMapper® Software Version 4.1
Getting Started Guide for Microsatellite Analysis (Pub. no. 4403672).

Click P (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.
e The status bar displays the progress of analysis as both:

— A completion bar extending to the right with the percentage completed
indicated

— With text messages on the left
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Examine and edit a project

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed upon completion of the analysis.

The Genotypes tab becomes available after analysis.

i® GeneMapper - AuthentiFiler_Example [Microsatellite] - gm Is Logged In Database FOSMULERDIILO3

Fie Edt Analysis Wiew Took Help

SOH HEF EEU ABEE P @ | Teests  accUTde ~yEB Fe Do

CErm T - — —
[ [ AuthentiFier
B I AutheribFern
) AusthenitFier
-1 AwthentFien
) AuthentiFien
- (D AuthentFler

[Sample Type  [Anatysis Method |
AuhertFier Anah shentiFiler_panel_Firu Z_80-400
AuthertFier Analysis | AuthentiFier_panel_Find GS500UIZ_B0-400
AuthertFier Analysis [AuthentiFier_panel_Fini GSS00LIZ_8O0-400
AuthertFier Anolysis | AuthentiFler_panel_Fini| GSB00LIZ_80-400
AuthertFler Analysis |AuthentiFiler_panel_Find GS500LIL_80-400
AuthertFier Analysis | uthentiFiler_panel_Find GSS00LIZ_80-400
AughertFier Analysis | AuthentiFer_panel_Find|GSS00LIL_B0-400

i
:

[ AuthertFier Analysis |AuthentiFiler_panel_Fine| GSG00LIZ_80-400
AuthertFier Analysis | AuihentiFler_panel_Fini| GSB00LIZ_80.400
AuthertFier Analysiz | AuthentiFiler_panel_Fini GSE00LIZ_80.400
[AuthertFier Anatysis | AuthentiFler_panel_Fin| GSB00LIZ_60-400
AuhertFier Analysis |AuthentiFiler_panel_Fine| GS500LIZ_50-400
AuthertFier Analysis |AuthentiFier_panel_Fan:| GSS00LIZ_B0.400
AuthertFler Anabysis ;Wﬂnmi«:&m_ﬂ)-lw

AEHEREREEE R

AuthertFier Anatysiz |AuthentiFder_parel_Fine | GSS00LIZ_50.400
BughertFier Analysis | AuthentiFier_panel_Fire| GS500UZ_50.400

22 |MushertFier [gDNATS
23 | BusheraFier- |gDNA1S
24 |AutherdFier- [gONAZD
35 |AutherdFaer. [gONAZT
% |AdherdFier |GDNAZZ
27 |AudhertFier |GONAZS
26 |AdherdFier |gDNAZE
23 |AuhertFier- |gONAZS

LA #harti e

AughertFier Anatysis | AuthentiFer_panel_Finc
‘AughertFier Anatysis |AuthentiFier_panel_Fin:|
AuthertFier Analysis ;Mheﬁfi«m_ﬁu:c
uthertFier Analysis |AuthentiFer_panel_Fr|GSE00UIZ_B0400 |

AuthertFier Analysis [AuthentiFier_panel_Fine| GS500UIZ_80-400
AuthentFier Anabysis |AuthentiFiler_panel_Find| GSB00UZ_B0-400
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Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper® Software features, allele filters, peak detection
algorithms, and project editing, refer to:

» GeneMapper® Software Version 4.1 Installation and Administration Guide
(Pub. no. 4403614) — Provides procedures for installing, securing, and
maintaining version 4.1 of the GeneMapper® Software.

* GeneMapper® Software Version 4.1 Getting Started Guide for Microsatellite
Analysis (Pub. no. 4403672) — The guide is designed to help you quickly learn to
use basic functions of the GeneMapper® Software.

» GeneMapper® Software Version 4.1 Online Help — Describes the GeneMapper®
Software and provides procedures for common tasks. Access online help by
pressing F1, selecting Help » Contents and Index, or clicking in the toolbar of the
GeneMapper® Software window.
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Chapter 4 Data Analysis
For more information

» GeneMapper® Software Version 4.1 Quick Reference Guide (Pub. no. 4403615) —
Provides workflows for specific analysis types and lists instruments, software,
and analysis applications compatible with the GeneMapper® Software.

* GeneMapper® Software Version 4.1 Reference and Troubleshooting Guide
(Pub. no. 4403673) — Provides reference information such as theory of operation
and includes troubleshooting information.
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Importance of
validation

Experiment
conditions

Experiments and Results

B OOVEIVIEW . oo 71
B Extra peaks in the electropherogram................... ... .. .. oo 71
B Sensitivity ... 78
B Mixturestudies. ... 79

Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations that
are critical for sound data interpretation (Sparkes, Kimpton, Watson et al., 1996;
Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

This chapter discusses many of the experiments performed by us and provides
examples of results obtained. We chose conditions that produced optimum PCR
product yield and that met reproducible performance standards.

IMPORTANT! Perform internal validation studies before using the AuthentiFiler™ Kit.

Extra peaks in the electropherogram

Causes of extra
peaks

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete 3" A nucleotide
addition (at the n-1 position), dye artifacts, and mixed DNA samples (refer to DNA
Advisory Board [DAB] Standard 8.1.2.2).

Stutter products

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the target STR
allele product (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter products
at tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).
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Extra peaks in the electropherogram

The proportion of the stutter product relative to the main allele (stutter percent) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Peak heights were measured for amplified samples at the loci used in the
AuthentiFiler ™ Kit:

e 210 genomic DNA samples (2 ng) from four population groups (Caucasian,
African-American, Hispanic, and Asian) were amplified using the AuthentiFiler""
Kit and electrophoresed on the Applied Biosystems® 3130x! Genetic Analyzer.
The data was analyzed for determination of the percentage of the stutter peaks.

All data were generated on the Applied Biosystems® 3130x! Genetic Analyzer.

Some conclusions from these measurements and observations are:

* For each AuthentiFiler Kit locus, the stutter percentage generally increases with
allele length, as shown in Figure 4 to Figure 6 on pages 72 to 73.

* Smaller alleles display a lower level of stutter relative to the longer alleles within
each locus.

¢ Each allele within a locus displays a consistent stutter percentage.

e Stutter filter sets in GeneMapper® ID, GeneMapper® ID-X, and GeneMapper®
software, calculated as the mean stutter for the locus plus three standard
deviations, are shown in Table 4 on page 73. Peaks in the stutter position that are
above the stutter filter percentage specified in the software are not filtered. Peaks
in the stutter position that have not been filtered and remain labeled can be
further evaluated.

¢ The measurement of stutter percentage for allele peaks that are off-scale may be
unusually high due to artificial truncation of the main allele peak.

Figure 4 Stutter percentages for D1051248, D151656 and D251338 loci. (Blue and green colors
indicate loci labeled with 6-FAM™ and VIC® dyes, respectively.)
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Extra peaks in the electropherogram

Figure 5 Stutter percentages for D2251045, D195433, and THO1 loci. (Black color indicates loci

labeled with NED™ dye)
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Figure 6 Stutter percentages for D25441, D651043, and D125391 loci. (Red color indicates loci

labeled with PET® dye)

Percent_Stutter
T

Table 4 Marker-specific stutter filter percentages for AuthentiFiler™ Kit loci

Locus® % Stutter
D10S1248 10.94
D10S1248 (+4 nt)¥ 3.49
D151656 12.76
D151656 (+4 nt)t 2.6

AuthentiFiler™ PCR Amplification Kit User Guide

73



74

Chapter 5 Experiments and Results
Extra peaks in the electropherogram

Locust % Stutter
D1S1656 (-2 nt)} 3.23
D251338 11.50
D2251045 16.49
D2251045 (+3 nt)8 6.84
D195433 10.24
THO1 4.26
D2S441 8.65
D6S1043 9.96
D125391 13.67

+ These percentages are used as stutter filters, in GeneMapper® 4.1 software:
AuthentiFiler_Final_Panels_GM4.1.txt; in GeneMapper® /D v3.2.1 software:
AuthentiFiler_Final_GMID3.2_Panels.txt; and in GeneMapper® ID-X software: GeneMapper® /D-X
AuthentiFiler_Final_stutter.txt

1 The -2 nt and tetranucleotide plus stutter filters are not included in GeneMapper® /D
AuthentiFiler_Final_GMID3.2_Panels.txt and GeneMapper= software v4.1
AuthentiFiler_Final_Panels_GM4.1.txt due to functional limitations of the software.

§ The D2251045 plus stutter can be added in the plus stutter ratio box in the AuthentiFiler_AnalysisMethod,
in the “Allele” tab and the plus stutter distances are from 2.25 and 3.75 for the GeneMapper® ID v3.2.1
software. The D2251046 plus stutter filters cannot be added in GeneMapper® v4.1 Analysis Method due to
functional limitations of the software.

IMPORTANT! The values shown are the values we determined during developmental
validation studies. We recommend that laboratories perform internal validation
studies to determine the appropriate values to use.

Addition of 3" A nucleotide

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This non-template addition results in a PCR product that
is one nucleotide longer than the actual target sequence. The PCR product with the
extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of the DNA at the 3’
end of the PCR product. The AuthentiFiler'" Kit includes two main design features
that promote maximum +A addition:

¢ The primer sequences have been optimized to encourage +A addition.

¢ The new, highly robust PCR chemistry allows complete +A addition with a short
final incubation at 60 °C for 10 minutes.

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. See Figure 7 on page 75 for examples of
incomplete and normal +A addition. Final extension incubation for longer than the
recommended 10 minutes may result in double +A addition, in which two non-
template adenosine residues are added to the PCR product. Double +A addition can
cause “shoulders” on the right side of main allele peaks, and is therefore to be avoided.
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Extra peaks in the electropherogram

Figure 7 Omitting the final extension step results in shoulders on main allele peaks due to
incomplete A nucleotide addition. Examples shown are D251338 (green) and D25441 (red) data

from an Applied Biosystems® 3130x( Genetic Analyzer using the AuthentiFiler™ Kit.

© omin
- Final Extension

~ 15 min
Final Extension

0 min
Final Extension

15 min
Final Extension

Due to improved PCR buffer chemistry, the lack of +A addition is generally less an
issue with the AuthentiFiler" Kit than with earlier generation kits. However,
“shouldering” of allele peaks may still be observed if the amount of input DNA is
greater than that recommended by the AuthentiFiler"" Kit protocol. Amplification of
excess input DNA may also result in offscale data.

Artifacts Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent occurrences
that are not observed consistently in a system (for example, spikes and baseline noise).
Due to improvements in PCR primer manufacturing processes, the incidence of
artifacts has been greatly reduced in the AuthentiFiler " Kit. AuthentiFiler " Kit
electropherograms are essentially free of reproducible dye artifacts within the kit's
read region of 70-287 nt. Figure 8 on page 76 shows the very low baseline level
fluorescence of a typical negative control PCR using the AuthentiFiler'" Kit.

Figure 9 on page 77 shows an example of a non-standard (minus 2-nt) stutter that may
be observed in D151656 locus that exhibit more complex nucleotide sequences
including regions of dinucleotide repeats. In cases where these stutter peaks exceed
the peak amplitude threshold (e.g., 50 RFU), they may be detected by analysis software
as additional alleles in the profile.

Most STR loci produce minus-stutter peaks as a by-product of PCR amplification. A
process of “slippage” has been proposed as a molecular mechanism for stutter, where
the Tag DNA polymerase enzyme “slips” on the template DNA during replication and
produces a minority PCR product that is shorter than the template strand, usually by
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Extra peaks in the electropherogram

one repeat unit. The stutter process may also occur in the opposite direction to produce
amplicon DNA that is usually one repeat unit longer than the template strand, termed
plus-stutter. While plus-stutter is normally much less significant than minus-stutter in
STR loci with tetranucleotide repeats, the incidence of plus-stutter may be more
significant in trinucleotide repeat-containing loci. The D2251045 locus in the
AuthentiFiler ™ Kit is a trinucleotide repeat locus, and shows an elevated level of
plus-stutter. The D10S1248 and D151656 loci in the AuthentiFiler™ Kit are
tetranucleotide repeat loci, and show an elevated level of plus-stutter. For example,
Figure 10 on page 77 is an electropherogram of the D2251045 locus showing plus
stutter. GeneMapper® ID-X analysis files supplied for use with the AuthentiFiler™ Kit
contain a plus-stutter filter to prevent these peaks from being called in normal profiles.

It is important to consider possible noise and artifacts when interpreting data from the
AuthentiFiler " Kit on the Applied Biosystems® 3500/3500xL and 3130/3130x! Genetic
Analyzers. Note that a high degree of magnification is used in the sample
electropherograms shown in Figure 8 through Figure 10 on pages 76 to 77.

Using a cycle number that is too high for the DNA input amount may cause artifacts,
including:
* Shoulder peaks due to incomplete +A addition.

* Pull-up peaks caused by poor spectral separation when fluorescence signals
exceeds the linear dynamic range for detection by the instrument.

Figure 8 Examples of fluorescence background in data with a 31 cycle PCR amplification produced on an
Applied Biosystems® 3130x( Genetic Analyzer (y-axis 70 RFU).
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Figure 9 Example of a -2 nt reproducible artifact at the D151656 locus. Data produced on an Applied Biosystems® 3130x(
Genetic Analyzer.
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Figure 10 AuthentiFiler™ Kit electropherogram showing plus stutter associated with the D2251045 STR locus. Data produced
on an Applied Biosystems® 3130x{ Genetic Analyzer.
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Sensitivity
Sensitivity

Importance of
quantification

Effect of DNA
quantity on results

78

The recommended amount of input DNA for the AuthentiFiler" Kit is 2.0 ng based on
quantification using either the NanoDrop"" 1000 Spectrophotometer or any other
quantification method of choice. Individual laboratories should determine the
optimum input DNA amount according to the quantification method in use in the
laboratory. For inhibited DNA, it is recommended to dilute the sample and amplify
provided that the sample has sufficient quantity of DNA. This is to reduce the
concentration of DNA. Adding more quantity of sample increases the quantity of
inhibitor as well. In Figure 11 on page 79, the genomic DNA from a Human Fibroblast
Cell Line was serially diluted from 4.0 ng to 0.125 ng. Full profiles (32 PCR products)
were consistently obtained at 0.125 ng.

If too much DNA is added to the PCR reaction, the increased amount of PCR product
that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).
e Off-scale data. Off-scale data is a problem because:

— Quantification (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

— Off-scale data can result in “pull-up” peaks in the other colors, which may
interfere in the allele call if falls in the fractionation range of a locus.

¢ Incomplete +A nucleotide addition.
To address these issues, reamplify the sample using less DNA.

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the alleles may occur because of stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.
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Mixture studies

Figure 11 Electropherograms for 27-cycle amplifications using 4 ng, 2 ng, 1 ng, 0.50 ng, 0.25 ng, and 0.125 ng, of genomic
DNA from Human Fibroblast Cell Line. Electrophoresis was performed on an Applied Biosystems® 3130x! Genetic Analyzer.
Note that the y-axis scale is magnified for the smaller input amounts of DNA.
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Mixture studies

Mixture studies

It is essential to ensure that the DNA typing system is able to detect DNA mixtures.
Typically, mixed samples can be distinguished from single-source samples by:

* The presence of more than two alleles at one or more loci
* The presence of a peak at a stutter position that is significantly greater in
percentage than typically observed in a single-source sample

¢ Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided by the
height of the higher peak (in RFU), expressed as a percentage. Mean, median,
minimum, and maximum peak height ratios observed for alleles in the AuthentiFiler™
Kit loci in unmixed human population database samples are shown in Figure 12
below.
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Mixture studies

Resolution of
genotypes in mixed
samples

80

Figure 12 Heterozygote ratios for 2 ng of input DNA amplified for 27 cycles with the

AuthentiFiler™ Kit. The distribution of intra-locus peak height ratios are expressed as a percent,
by locus. Green boxes show the middle 50% or interquartile range (IQR). Box halves below and
above median show the second and third quartile, respectively. “Whiskers” indicate 1.5 IQR from
the upper and lower margins of the IQR. Red diamonds are outlier data points more than 1.5

QR

from the median.
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If an unusually low peak height ratio is observed for one locus, and there are no other
indications that the sample is a mixture, the sample may be reamplified and
reanalyzed to determine if the imbalance is reproducible. Possible causes of imbalance
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locus are:

Degraded DNA

Presence of inhibitors

Extremely low amounts of input DNA

A mutation in one of the primer binding sites

Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele

A sample containing DNA from two sources can comprise (at a single locus) any of the
seven genotype combinations (see below).

Heterozygote + heterozygote, no overlapping alleles (four peaks)
Heterozygote + heterozygote, one overlapping allele (three peaks)
Heterozygote + heterozygote, two overlapping alleles (two peaks)
Heterozygote + homozygote, no overlapping alleles (three peaks)
Heterozygote + homozygote, overlapping allele (two peaks)
Homozygote + homozygote, no overlapping alleles (two peaks)

Homozygote + homozygote, overlapping allele (one peak)
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Mixture studies

Specific genotype combinations and input DNA ratios of the samples contained in a
mixture determine whether or not it is possible to resolve the genotypes of the major
and minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak
heights on Applied Biosystems® instruments provides additional valuable data to aid
in resolving mixed genotypes.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from
known reference sample(s).

Limit of detection Mixtures of two DNA samples from Human Fibroblast Cell Line were examined at
of the minor various ratios (1:0, 1:5, 1:10, 1:20). The total amount of genomic input DNA mixed at
component each ratio was 2.0 ng. The samples were amplified in a GeneAmp® PCR System 9700,

then electrophoresed and detected using an Applied Biosystems® 3130x! Genetic
Analyzer.

The results of the mixed DNA samples are shown in Figure 13 on page 82 where
samples A and B were mixed according to the ratios indicated. The minor component
allele calls at non-overlapping loci are highlighted. Detection of full profiles for the
minor contributor was possible at ratios of 1:5 (0.4:1.6 ng) and 1:10 (0.2:1.8 ng).
Generally, 1:20 ratios resulted in partial profiles for the minor component at the tested
concentrations. The profiles of these samples are described in Table 5 on page 82.
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5 Chapter 5 Experiments and Results
Mixture studies

Figure 13 Amplification of DNA mixtures at various ratios. Panels show electropherograms for (top to bottom): Minor
contributor only, 1:5 mixture (minor:major), 1:10 mixture,1:20 mixture, and Major contributor only. The experiment was
performed with a 27 cycle amplification.
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Table 5 Genotypes of mixed DNA samples

Locus Sample A Genotype Sample B Genotype
D10S1248 13, 17 14
D151656 12, 16 12,13

Amelogenin XY X
D251338 16, 20 18, 24
D2251045 11,15 11,16
D195433 14 12,15

THO1 7,8 9.3
D2S441 " 1, 14
D6S1043 12,18 12,19
D12S391 15, 23 15, 19
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Observation

Possible causes

Recommended actions

Faint or no signal from
both, the AuthentiFiler™
DNA Control 007 and the
DNA test samples at all
loci

Incorrect volume or absence of either
Master Mix or Primer Set

Repeat amplification using correct reagent
volumes.

No activation of enzyme

Repeat amplification, making sure to hold reactions
initially at 95°C for 11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex Master Mix thoroughly.

Primer Set exposed to too much light

Store Primer Set protected from light.

GeneAmp® PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

Tubes/plate not seated tightly in the
thermal cycler during amplification

Push reaction tubes/plate firmly into contact with
block after first cycle. Repeat test.

Wrong PCR reaction tubes or plate

Use Applied Biosystems® MicroAmp® Reaction
Tubes with Caps or the MicroAmp® Optical 96-Well
Reaction Plate for the GeneAmp® PCR System 9700
or Veriti® 96-well Thermal Cycler.

MicroAmp® Base used with tray/
retainer set and tubes in GeneAmp®
PCR System 9700

Remove MicroAmp® Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

See Chapter 3, “Electrophoresis” on page 23, for
instructions on recommended actions on the 3130/
3130x(, and 3500/ 3500xL.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Appendix A Troubleshooting

Observation

Possible causes

Recommended actions

Positive signal from
AuthentiFiler™ DNA
Control 007 but partial or
no signal from DNA test
samples

Quantity of test DNA sample is below
assay sensitivity

Quantify DNA and add 2.0 ng of DNA for a 27 cycle
amplification. Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes

Quantify DNA and add minimum necessary volume.
Repeat test.

Wash the sample in a Centricon®-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA.

Dilution of test sample DNA in water or
wrong buffer (for example, TE formula
with incorrect EDTA concentration)

Redilute DNA using low-TE Buffer (with 0.1 mM
EDTA.

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

Interpret according to laboratory procedures.

Note: Additional information will be provided on
completion of validation.

Incomplete 3" A base addition
(n-1 nt position)

Addition of excess DNA to the reaction will
contribute to the occurrence of incomplete 3’ base
addition. Quantify DNA and add 1.0 ng of DNA to the
reaction. Repeat test. Also be sure to include the
final extension step of 60°C for 10 min in the PCR.

Cell line you are interrogating has
genomic instability or genetic
duplications

Some cell lines exhibit more than 2 alleles at one or
more loci due to genomic instability, which can be a
characteristic of the cell line. One can confirm this
by comparing the tested sample profile with the
reference profile for that cell line. If the profile of the
tested sample exhibits an additional allele, the
possibility of genetic drift during frequent
subculturing should be evaluated.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure cycle number is optimized according to
instructions on page 21. Repeat PCR amplification
using fewer PCR cycles or use your laboratory’s
SOP to analyze off-scale data.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed and
used for analysis.

Too much DNA in reaction

Use recommended amount of template DNA: 2.0 ng
at 27 cycles.

Incomplete denaturation of double
stranded DNA

Use the recommended amount of Hi-Di"™
Formamide and perform heat denaturation
according to instructions in Chapter 3,
“Electrophoresis”.
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Appendix A Troubleshooting

Observation Possible causes Recommended actions
Poor peak height Incorrect thermal cycler parameters Check the protocol for correct thermal cycler
balance parameters.

GeneAmp® PCR System 9700 with
Aluminum 96-Well block or third-party
thermal cyclers

Use Applied Biosystems® GeneAmp® PCR System
9700 with silver, gold-plated silver blocks or Veriti®
96-well Thermal Cycler only.
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Materials and equipment not included

The tables below list optional equipment and materials not supplied with the

AuthentiFiler™ Kit. Unless otherwise noted, many of the items are available from

major laboratory suppliers (MLS).

Ordering Information

Equipment

Cat. number

Applied Biosystems® 3500/3500xL Genetic Analyzer for Human Identification

Applied Biosystems® 3130/3130x( Genetic Analyzer

Contact your local Life
Technologies sales

representative.
GeneAmp® PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878
Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443
Veriti® 96-well Thermal Cycler 4375786
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS
Item Cat. number

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4® polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4® polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
GeneScan™ 600 LIZ® Size Standard v2.0 4408399

Note: For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the Applied Biosystems® 3500/

3500xL Genetic Analyzer User Guide (Pub. no. 4401661)
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E Appendix B Ordering Information

Materials and equipment not included

Item Cat. number
3130/3130x! Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4® Polymer for 3130/3130x{ Genetic Analyzers 4352755
3130/3130x( Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ® Size Standard 4322682
Or Or
GeneScan™ 600 LIZ® Size Standard v2.0 4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp® Optical 96-Well Reaction Plate N8010560

For a complete list of parts and accessories for the 3130x! instrument, refer to Appendix A of the Applied Biosystems® 3130/
3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Pub. no. 352716).

PCR Amplification
MicroAmp® 96-Well Tray N8010541
MicroAmp® Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp® 8-Tube Strip, 0.2-mL N8010580
MicroAmp® 8-Cap Strip N8010535
MicroAmp® 96-Well Tray/Retainer Set 403081
MicroAmp® 96-Well Base N8010531
MicroAmp® Clear Adhesive Film 4306311
MicroAmp® Optical Adhesive Film 4311971
MicroAmp® Optical 96-Well Reaction Plate N8010560
Other user-supplied materials
Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA 05 M MLS
Vortex MLS
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PCR Work Areas

Work area setup and labdesign................... 89
PCRsetupworkarea .......... ..o 89
Amplified DNA work area . .............uuuuuuiiiiiiiiiiiiinn 90

Work area setup and lab design

The sensitivity of the AuthentiFiler"" Kit (and other PCR-based tests) enables
amplification of minute quantities of DNA, necessitating precautions to avoid
contamination of samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e (Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack

* Pipette tips, sterile, disposable hydrophobic filter-plugged
* Pipettors

* Tube decapper, autoclavable

e Vortex
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Amplified DNA work area

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:
e GeneAmp® PCR System 9700 with the Silver 96-Well Block
* GeneAmp® PCR System 9700 with the Gold-plated Silver 96-Well Block

IMPORTANT! The AuthentiFiler™ Kit is not validated for use with the GeneAmp®
PCR System 9700 with the Aluminium 96-Well Block. Use of this thermal cycling
platform may adversely affect performance of the AuthentiFiler'" Kit.

o Veriti® 96-well Thermal Cycler

IMPORTANT! The AuthentiFiler'" Kit is not validated for use with the Veriti® 96-
Well Fast Thermal Cycler (Cat. no. 4375305). Use of this thermal cycling platform
may adversely affect performance of the AuthentiFiler™ Kit.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

* Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

* Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

* Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

* Handle chemical wastes in a fume hood.

¢ Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

¢ After emptying a waste container, seal it with the cap provided.

* Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

¢ IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Specific chemical

. CAS Chemical Phrase
handling

26628-22-8 | Sodium Azide Sodium azide may react with lead and copper
plumbing to form highly explosive metal azides.

Biological hazard safety

z WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.
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Appendix D Safety
Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following;:

In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

® Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29cfr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

¢ Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Related documentation

Documentation and Support

The following related documents are shipped with the system:

Document Pub. number
AuthentiFiler™ PCR Amplification Kit Quick Reference 4479556
Applied Biosystems® 3130/3130x( Genetic Analyzers Using Data Collection 4363787
Software v3.0 User Bulletin
Applied Biosystems® 3130/3130x( Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems® 3130/3130x( Genetic Analyzers Maintenance, 4352716
Troubleshooting, and Reference Guide
Applied Biosystems® 3130/3130x( Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems® 3130/3130x( Genetic Analyzers AB Navigator Software 4359472
Administrator Guide
Applied Biosystems® 3130/3130x( DNA Analyzers User Guide 4331468
Applied Biosystems® 3730/3730xl Genetic Analyzer Getting Started Guide 4359476
Quantifiler® Kits: Quantifiler® Human DNA Quantification Kit and Quantifiler® 4344790
Y Human Male DNA Quantification Kit User's Manual
GeneMapper® ID Software Version 3.1 Human Identification Analysis User 4338775
Guide
GeneMapper® ID Software Versions 3.1 and 3.2 Human Identification Analysis 4335523
Tutorial
Installation Procedures and New Features for GeneMapper® ID Software v3.2 4352543
User Bulletin
GeneMapper® ID-X Software Version 1.0 Getting Started Guide 4375574
GeneMapper® ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper® ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis] Getting Started 4396773
Guide
GeneMapper® ID-X Software Version 1.1 (Mixture Analysis) Quick Reference 4402094
Guide
GeneMapper® ID-X Software Version 1.2 Quick Reference Guide 4426482
GeneMapper® ID-X Software Version 1.2 Reference Guide 4426481

Note: To open the user documentation, use the Adobe® Reader® software available
from www.adobe.com
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Documentation and Support
Obtaining SDSs

Note: For additional documentation, see “Obtaining support” on page 96.

Obtaining SDSs

Safety Data Sheets (SDSs) are available from www.lifetechnologies.com/sds

Note: For the SDSs of chemicals not distributed by Life Technologies, contact the
chemical manufacturer.

Obtaining support

For HID support:

¢ In North America - Send an email to HIDTechSupport@lifetech.com, or call
888-821-4443 option 1.

* Outside North America — Go to www.lifetechnologies.com/contactus.html and
select the appropriate country from the drop-down menu.
For the latest services and support information for all locations, go to:

www.lifetechnologies.com

At the website, you can:

* Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

® Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

* Obtain information about customer training

¢ Download software updates and patches

Limited Product Warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life

Technologies’ website at www.lifetechnologies.com/termsandconditions. If you have
any questions, please contact Life Technologies at www.lifetechnologies.com/support.
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